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Abstract 

 

Congratulations on your purchase of an I-Mark Machine, this software is industry leading, 

helping you make your mark today with tomorrow's technology. 

In one of the toughest years of the world’s economy, CMT Leaders made a massive 

decision to invest heavily in product development in a down economy. They asked themselves 

to design a DREAM LINE product, something more unique and better than the dot peen and 

scribe systems. If they could sell anything, what would it be? As the downward economy took its 

toll, they made the bold move to continue investing in 2009. Then, in January of 2010, came the 

great payoff: the I-Mark software, controller, and machines became a new brand name for CMT. 

Following the Blue Ocean Strategy Columbia was founded on, they pushed forward to once 

again become industry-leading in both software and hardware—as marking became more 

accessible in terms of speed, ease of use, and connectivity—that no other competitors had at 

the time. Most importantly, it came at industry-low prices and was 100% made in the USA! 

I-Mark software is a layout creation and editing platform used to design marking 

programs for all I-Mark dot-peen and scribe marking systems. This document provides an 

overview of the core features, operating workflows, 

and essential processes required to develop and 

manage marking layouts within the software 

environment. Practical application examples are 

included to illustrate real-world implementation, 

along with key considerations for achieving effective 

product identification and traceability. The objective 

of this manual is to equip prospective and current 

users with a clear understanding of I-Mark software 

capabilities, enabling informed planning, efficient 

deployment, and successful integration into 

industrial marking operations. 
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Contact CMT 

Website: http://marking-machines.net 

Telephone: +1 (586) 949-8400 

E-Mail:  

Quotes for spare parts: quotes@columbiamt.com 

Service Request: service@columbiamt.com 

If your machine is under warranty free support will be provided, or a service ticket will be quoted. 

Quick links included below.  

 

RMA – Return Material Authorization is required for returning 

product for repair. 

 

Support Request – The easy online form is used to request 

remote support. If your machine is under warranty this is 

free.  

 

Registration – Register your product to get periodic support 

updates, and unlimited licensing on the software.  

http://marking-machines.net/
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Introduction  

Purpose of This Manual 

This manual provides instructions for the installation, configuration, and operation of the I-Mark 

Software when used with Columbia Marking Tools marking systems. 

The purpose of this document is to guide trained operators, technicians, and system integrators 

in the proper use of the software and its associated marking equipment. 

This manual describes software functions, system configuration, layout creation, and marking 

operation. It does not replace required safety training or company operating procedures. 

 

Product Overview 

I-Mark Software is the control platform used to create, edit, and execute marking layouts on 

compatible Columbia Marking Tools systems. The software enables users to design marking 

data and transmit that data directly to the connected marking machine. 

The layout window represents the exact data that will be marked on the material. Any text, 

geometry, or entities placed within the layout will be reproduced by the marking system 

according to the selected machine configuration and preset parameters. 

This manual uses the M-Series platform as the primary example. Functionality may vary slightly 

depending on machine configuration. The I-Mark software is also used with the I-Mark I-Series 

and C-series.

 

Intended Users 

• Trained machine operators 

• Maintenance technicians 

• Manufacturing engineers 

• System integrators 

Note: Only qualified personnel should install, configure, or operate marking equipment. 
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Safety Notice 

Marking systems may include moving mechanical components, electrical systems, and 

depending on configuration, dot-peen or scribe marking technology. 

Improper operation may result in equipment damage or personal injury. 

Operators are responsible for: 

• Following all facility safety protocols 

• Using appropriate personal protective equipment (PPE) 

• Ensuring guards and safety devices are properly installed and functional 

• Receiving proper training prior to operation 

Refer to the Safety section of this manual before operating the system. 

Revision Information 

This manual applies to the current release of I-Mark Software (2.4.1.8186) at the time of 

publication. Software updates may introduce changes not reflected in this document. 
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I-Mark Requirements  

What is I-Mark? 

I-Mark is a professional software package designed by Columbia Marking Tools used to 

interface with programmable industrial marking systems.  This product is used to create marking 

layouts, manage networked machines, perform simple maintenance and control any marking 

system in Real-Time. 

System Requirements  

I-Mark has been designed to work with Windows operating systems of 32 or 64 bit. 

Minimum 

• Pentium® class CPU – 1 Ghz minimum 

• 65536 color video card - 1024x768 

• 512 Mb RAM 

• Microsoft Windows® 2000 or later (works under Windows ME with limited performances). 

• 10/100 T-Base Network Card  

Recommended 

• Pentium® class CPU - 1.6 Ghz or more 

• True Color Video Card (24 or 32 bits – 16.8 M colors) - 1280x1024 

• 1GB RAM 

Windows Requirements 

• NET Framework 4.0 minimum 

• Visual C++ 8.0 or greater 

• Windows 32- or 64-bit operating systems 

Windows Updates 

• Windows updates may cause software communication issues 

• If problems occur after an update: 

o Reinstall I-Mark to allow the software to reconfigure with updated Windows 

settings. 
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Installation Guide 

If you have not done so, please install the I-Mark software now.  

If you did not purchase a PC* with your CMT machine you will need to load the software 

provided with your purchase of your CMT machine. This section will help you get the I-Mark 

marking software installed on your PC*.  

*All M Series and any custom systems that are supplied with a PC have the I‐Mark 

software preloaded. For these systems proceed to understanding which mode is best for 

you. 

This Section is written with instructions to install the I-Mark software with USB connection 

support.  

It is very important to install the software in the order listed with this instruction manual 

to limit the possibility of errors.  

Locate your USB flash drive found in your quick start guide.  

This is your time limited software-unrestricted license provided with the registration of your I-

Mark. 

 

Register your I‐Mark at: 

http://www.marking-machines.net/I-MarkRegistration.html 

For more information go to section, “How to Update Your I-Mark License”. 

http://www.marking-machines.net/I-MarkRegistration.html
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Installing Software: 

The Installation guide will walk you through setup of the software by simply reading the on-

screen instructions you can get through the installation painlessly. Be sure to use the default 

settings and installation locations when going through the installer wizard.  

 

Software must be installed on a PC running Windows®. This software is used to design the 

marketing layout. 

Steps: 

1. Insert provided USB thumb drive into USB port in PC.  

2. If program does not auto-start, proceed to use the 

windows explorer to access to device from your 

computer, and run the rile ../setup/I-Mark-Setup.exe. 

3. Follow on screen setup menu to complete the 

installation. Read the E.U.L.A for program and version 

highlights.  

 

 

CMT Recommends the Install Now Choice, unless otherwise specified to not do so.  

 

For the successful completion of software download 

please allow the installation application to make 

changes to your device. 

 

Congratulations on the successful installation.  

 

4. Run the I-Mark program from the I-Mark Icon on 

the desktop.   
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Understanding Which Software Mode is Best for You 

When launching the software, you must first select the operating mode: Basic Mode or 

Advanced Mode.  

Basic Mode provides a streamlined interface with essential marking functions. It is designed for 

quick setup and is recommended for stand-alone 

marking machines. 

Advanced Mode is recommended by CMT for system 

integrators who require expanded I/O control, 

communication capabilities, and advanced configuration 

options available on I-Mark controllers. 

SELECT BASIC IF NOT TOLD SO OTHERWISE. 

CONTACT CMT FOR FURTHER CALRIFICATIONS.  

Custom software settings may restrict some of the advanced software settings. The software 

may be restricted for single machine use or may be limited to I/O protocols and 2D functionality. 

In addition, advanced software applications may have different access levels to ensure that 

marking legends and settings are not changed inadvertently. And may even be customized to 

allow access to certain machines on the network and not others, depending on responsibility. 
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How to Update Your I-Mark License Key 

Our term-sale products ship with a temporary license key. When this key expires, you will see a 

“Key Expired” Fault pop up if you try to make a mark and the machine will not run. We 

recommend registering your product before this key expires to avoid interruptions in production. 

Here’s how: 

Retrieve your Machine ID number:  

1. Ensure the Controller is connected to the operator PC and powered on.  

2. Open the I-Mark Software and connect to the Controller as though you were preparing to 

make a mark.  

3. Click on “Diagnostics” and document the 8-character Machine ID. You will need to 

provide this on the registration form later.  

Note: The days remaining on your temporary license is shown under the Machine ID. 

Online Registration Form 

I-Mark Registration 

Click the link above to access our online registration form 

and provide the requested information. The information 

will automatically be emailed to us at CMT. Allow one 

business day for a response. 

If you have trouble clicking the link, you may also cut and 

paste http://marking-machines.net/I-

Mark_Registration.html in your browser to reach the 

registration form. 

Upon receiving your Registration info, CMT will verify 

your purchase and supply you with a permanent License 

Key.  

https://marking-machines.net/I-Mark_Registration.html
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1. With the Controller on and connected to the operator PC, return to “Diagnostics” in the I-Mark 

Software.  

2. Click on “Update Key” in the System Actions group.  

3. When the dialog window pops up, simply copy and paste the key CMT provided into the field 

and click “Submit.”   

4. The I-Mark software will do a soft reset of the Controller and be ready to use again.   

Note: in some instances, when the Controller reconnects to the I-Mark software, the Machine ID 

will not be visible. Simply restart the I-Mark software and power cycle the controller to clear this 

error. 
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Navigating The Workspace  

Launching the I-Mark Software 

The I-Mark software can be launched from the desktop shortcut or from the application 

directory. 

Select the I-Mark icon to start the software. 

Once the software has fully loaded, the Start Page will be displayed. 

Workspace 

A Workspace is a collection of layouts, files, machines, and global settings associated with 

specific I-Mark controllers. It provides a way to group these items for efficient organization, 

management, and monitoring by an operator or system. 

Note: The I-Mark program interface, including window arrangement and navigation, may vary 

depending on user preferences, applications, or system configurations. 

Understanding the Workspace 

A Workspace defines the relationships between: 

• Marking layouts 

• Controllers 

• Graphics and fonts 

• Global system settings 

By using a Workspace, the software displays only the machines and data relevant to a specific 

operation, rather than all controllers on the network. 

Practical Example 

In a large manufacturing facility, multiple machining cells may exist, each dedicated to a specific 

part or process. Each cell can contain one or more I-Mark controllers with their own layouts, 

graphics, and settings. 
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A Workspace allows you to: 

• Group only the controllers for a specific cell 

• View and manage only the layouts and machines assigned to that group 

• Prevent accidental interaction with machines outside your responsibility 

When a Workspace is opened, only the controllers mapped to that Workspace appear in the 

Navigation Pane, providing a cleaner interface and simplifying management. 

Workspace Scope and Parameters 

A Workspace defines the machine parameters and the global I-Mark environment, including: 

• Which machines are available for marking (mapped controllers) 

• Global machine settings 

• Global counter settings 

• Global I/O configuration 

By creating a new Workspace, the system searches for machines connected to your computer 

or network and allows you to connect to them. Once connected, you can begin editing their 

properties. 

 

Creating a New Workspace 

When a new Workspace is created, the system will search for marking machines connected to 

the computer or available on the network. The user may then select which machines to 

associate with the Workspace. Once connected, the properties of those machines can be 

viewed and edited. 
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A new Workspace can be created in two different ways: 

Method 1: ORB Menu 

1. Select New 

Workspace from 

the ORB menu. 

(The ORB is the 

Intelli-Mark symbol 

located in the 

upper-left corner of 

the main application 

window.) 

Method 2: Start Page 

1. From the Start Page, select Advanced Mode. 

2. Choose Create New Workspace to create multiple 

Creating multiple is a advanced mode only feature 

Note: Workspace creation is available only in Advanced Mode. 

 

Then choose Basic Mode vs Advanced Mode 

The I-Mark software operates in two modes: Basic Mode and Advanced Mode. 

• Basic Mode 

o Displays all marking machines detected on the network 
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o Does not restrict machine visibility 

o Does not use Workspaces to filter controllers 

• Advanced Mode 

o Enables the creation and use of Workspaces 

o Allows the user to limit which machines are visible and accessible 

o Recommended for production environments with multiple controllers 

By using Advanced Mode with Workspaces, operators can reduce screen clutter, limit machine 

access, and improve overall system organization. 

 

 

Opening an Existing Workspace 

To open an existing Workspace: 

1. Select Open Workspace from the ORB menu. 

2. Use the file explorer dialog to navigate to the desired Workspace file. 

3. Select the file and click Open. 

Default Workspace file location: 

C:\My Documents\I-Mark 

 

Saving a Workspace 

To save changes to a Workspace: 

1. Select Save Workspace from the ORB menu. 

Important notes: 

• Workspaces are not saved automatically 
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• An asterisk (*) displayed next to the Workspace name indicates unsaved changes 

• Workspace files use the .ctml file extension 

• Saved Workspace files are stored in the I-Mark data directory 

 

Workspace File Status 

Indicator 

If a Workspace has been 

modified but not saved, an 

asterisk (*) will appear next to the 

file name in the Main Work Area 

tab. Once the Workspace is 

saved, the asterisk will be 

removed. 

 

Workspace files are not created or saved 

automatically. 

 

The file is not automatically created nor saved. The 

filename on the tab in the Main Work Area will be 

followed by an asterisk if the file has note been 

saved in its current state. 

When the file is saved the file is located in the data directory under the Intelli-Mark program files. 

The extension name is .ctml.
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I-Mark Interface Overview 

 

Creating a Workspace 

Workspaces Overview 

Creating a new workspace is available only in Advanced Mode. 

Workspaces are the only method by which the user can limit which marking 

machines the software attempts to locate and communicate with. 

• In Basic Mode, all machines detected on the network are displayed in the Navigation 

Pane. 

• In Advanced Mode, Workspaces allow the operator to select which machines on the 

network will be accessed. 

By creating multiple Workspaces, operators can: 

• Restrict machine visibility 

• Reduce interface clutter 

• Improve operational safety 
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• Simplify management of multi-controller environments 

 

Creating a New Workspace 

Steps to Create a Workspace: 

1. Make sure you have selected advanced mode if you have not, go to file menu and select 

change user mode, then select advanced.  From there click on New Workspace.  

2. A workspace is saved as a .cmtw file. To open it, click File → Open, and select your 

workspace file. 

o Opening a new workspace will reset i-Mark for that workspace. 

o If this is your first time opening it, you may overwrite existing files if duplicates 

exist. Don’t worry—these files are not lost, just replaced by exact duplicates. 

3. Click on Workspace in the navigation bar, then select the controller you are using that 

is connected under the workspace bar. 

o The system will load the controller and PC together. 

o When prompted to select which files to use, choose use marking files if desired 

files are stored on controller, or choose use files in workspace if files are 

stored on pc. 

4. If using advanced mode, make sure you set your default workspace, so when I-Mark 

application launches it launches with that workspace. Go to file menu, select options, 

from options scroll to the bottom then under Miscellaneous. Click on automatic 

workspace to load. Then select the button with three dots, which prompts a file open 

function to your file directory. From there select the workspace you wish to set as the 

default.  

 

Using Multiple Workspaces with Multiple Graphics (Advanced) 
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Note: This is an advanced scenario. Most operators will not need to use multiple workspaces 

with multiple graphics. Only use this approach if you are managing several layouts or complex 

graphics simultaneously. 

• When using multiple layouts with your own graphics, it is recommended to create a 

separate workspace for each project and use Advanced Mode, as multiple workspaces 

may be required. 

• Workspaces allow you to limit which machines the software attempts to 

communicate with, reducing the risk of errors or confusion when working with multiple 

controllers. 

• Ensure your graphics are clean and optimized before using them in multiple 

workspaces to avoid system errors. 

 



 

Page 21 

 

Workspace Ribbon – Structure and Navigation 

Ribbon Overview  

Ribbon Overview 

The I-Mark software uses a ribbon-based interface similar to other Windows-based applications. 

The ribbon is located across the top of the application window and displays tool groups based 

on the active tab and current user context. 

Selecting a tab (File, Home, Layout, Entity, Marking, View, Help, or Settings) updates the ribbon 

to display the commands relevant to that function.  

 

Ribbon content is context-sensitive. Certain tabs, such as the Entity tab, appear only when 

applicable. 

Quick Tab Performance Summary 

Home Tab: This will be your base of operations for managing projects – save and open 

previously saved – along with managing your machine – connecting and disconnecting.  

Layout Tab: The layout tab is where you will create a layout you wish to run along with the 

layout settings – essentially you can create a visual representation of what you wish to mark on 

your part.  

Entity Tab: This tab will open once you have created a text. Once the text appears on your 

layout you click on the text, and you will see the entity tab automatically added to your tool bar.  

Marking Tab: Will allow you to connect or disconnect from the controller.  

View Tab: In the view tab you can customize your layout, essentially customizing what you see 

in the application environment to best suit your work.  
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Setting Tab: You will find basic machine settings: the speed of your pin, and set your specific 

scribe mode.  

Ribbon Navigation Guide 

Home Tab 

 

The Home tab serves as the primary starting point for layout and machine management. 

From the Home tab, you can: 

• Create new layouts 

• Open previously saved layouts 

• Save the active layout 

• Undo or redo changes in the current layout 

• Connect to or disconnect from a marking machine 

• Refresh the network to locate available machines 

 

Layout Tab 

 

The layout tab will open once you create a layout – by selecting “create new layout” in the home 

tab, though this can also be done by opening a previously saved layout.  
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This tab is used to define the contents of the marking layout and insert entities into the layout. 

• Graphic 

• Line  

• Text 

• Data Matrix 

• UID Code 

• Set Waypoints 

Selecting any of these options will automatically open it in your layout. 

Entity Tab 

The Entity tab opens in the ribbon after text has been created in the layout. Selecting the text 

automatically switches the ribbon to the Entity tab. 

Use the Entity tab to create, modify, and teach elements within the layout. 

In the entity tool bar, you will: 

• Select your starting position and the alignment of the green dot within your entity 

• Group and align your layouts (for when you have multiple lines) 

• Manually choose your X and Y coordinates if known 

• Teach your layout position 

• Enter/ modify your text reading 

• Choose your font 

• Choose your character height, width and separation.  

• Adjust angles and create a radius 

• Change the appearance of your text.  

Figure 1 Graphic Entity 
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Figure 2 Text Entity 

Figure 3 Line Entity 

 

Figure 4 Data Matrix 

 

Figure 5 UID Entity 

 

Figure 6 Waypoint 

Marking Tab 

 

The Marking tab is used to manage communication between the software and the marking 

controller. 

From this tab, you can: 

• Connect to the controller 
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• Disconnect from the controller 

 

View Tab 

 

 

The View tab allows customization of the application environment. 

• Make your layout screen larger or smaller 

• Customize your layout window by adding grid lines, rulers, and axis labels 

• Adding navigation window, marking window properties windows and marking window to your 

layout screen 

 

Help Tab 

 

The Help tab provides access to system help and support resources. 

Settings Tab 

You will find basic settings: the speed of your pin, and set your specific scribe mode.  
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Connecting to Machine 

If the system was purchased as a complete package, it may be configured for automatic 

connection. In this case, the machine will connect during startup. 

 

After reviewing the I-Mark ribbon interface, the next step is to connect the marking machine to 

the IM200 controller.  

Procedure 

1. Select the Marking tab located on the ribbon at the top of the 

screen. 

2. Click Connect to Marking Machine. 

3. The system will verify network status and 

initiate pairing between the marking head and 

the IM200 controller. 

4. When the connection is successful, a green 

check mark will appear next to the machine ID 

in the left navigation pane (e.g., IM-M75, IM-

M125, IM-M200). 

Select the machine ID to open the controller window.  

5. The machine control page will open. This is the active control interface for the connected 

marking system. 

Control Page Functions 

The control page allows you to: 

• Download marking programs to the machine 

• Adjust machine settings 

• Execute marking operations 
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Once connected, the system is ready for layout creation and program execution. 

 

 

Troubleshooting 

If the machine does not pair: 

• Verify network connections. 

• Confirm the controller and marking head are powered on. 

• Check and modify the IP address configuration as needed. 

• Verify you are using matching hardware and matching software.  

If no systems are available, check the following issues: 

1. Is the computer that I-Mark is running on connected to the network? 

2. Are the Marking Systems connected to the Network? 

3. Are the Marking Systems on? 

4. Have the Marking Systems been properly configured/mapped? 
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Disconnecting from the Network and Marking 

Machines 

To safely disconnect a computer from the network and ensure all changes are retained, 

complete the following steps in order: 

1. Save the Workspace 

Saving the Workspace ensures that all layout and configuration changes made during the 

session are stored within the software environment. 

2. Download to All 

Perform a Download to All operation to transfer the current Workspace data to all 

connected controller(s). This ensures that the most recent changes are saved directly on 

the marking machine controllers. 

3. Disconnect from Marking Machine(s) 

Select Disconnect from Marking Machine(s) on the Home tab to terminate 

communication between the software and the connected marking systems. 

After completing these steps, you may safely close the I-Mark application or disconnect the 

computer from the network. 
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Creating a New Layout 

After the marking machine has been detected and connected, create a new marking 

layout. 

A marking layout is the visual representation of the data the machine will mark. The content 

placed in the layout window will be reproduced exactly on the material. 

These files are not automatically created nor saved. The filename on the Main Work Area 

tab will be followed by an asterisk if the file has note been saved in its current state. 

When the file is saved the file is located in the data directory under the I-Mark program 

files. The extension name is .ctml 

Procedure 

1. Select the Home tab on the ribbon. 

This icon is located in two places: the Orb Menu and the Home Menu Ribbon. This 

command will create a blank layout in the current workspace. 

2. Click Create New Layout. 

3. In the pop-up window, select the appropriate machine type. 

o In most cases, only one machine option will be available. 

o If multiple machines are listed, select the machine intended for marking. 

4. Do not modify the hardware configuration settings. 

Do not change: 

o Marking width 

o Marking height 

o Axis configuration 

These settings are automatically configured based on the selected machine – DO 

NOT TAMPER WITH. 

mk:@MSITStore:C:/PROGRA~2/I-MARK~1.804/I-Mark.chm::/Main_Work_Area.htm
javascript:TextPopup(this)
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5. If the marking application requires custom parameters, adjust speed and dwell time as 

necessary according to application requirements. 

6. Select the desired preset: 

o Draft – High-speed marking for mock-ups with reduced precision. 

o Normal – Balanced speed and quality for standard production marking. 

o High Resolution – Reduced speed for maximum clarity and precision. 

7. Select OK to create the layout. 

The new layout window will open and is ready for content creation. 

 

You will notice that the I-Mark program has already moved to the Layout ribbon for you 
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Inserting Entities 

After creating a new layout, the software will automatically open the layout window and display 

the layout ribbon. 

The layout must contain the data that will be marked. Each individual piece of marking data is 

referred to as an entity. 

Available Entity Types 

To add content to the layout, select the 

appropriate entity type from the ribbon. The 

following entity types are available: 

• Graphic 

• Line 

• Text 

• Data Matrix 

• UID Code 

Each inserted entity will appear in the layout window and represent the exact content to be 

marked on the material. 

Adding Text 

Text entities allow you to insert alphanumeric content into the marking 

layout. 

Procedure 

1. Select the Text icon from the ribbon. 
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A text entity will appear in the layout window. 

2. Double-click the text entity to 

open the text editor. 

3. Enter the desired text in the 

editor. 

4. Select Accept. 

The text editor will close, and the 

entered text will appear in the layout 

workspace 

 

 

 

Reverse Printing for Multiple Lines 

When marking multiple lines of text, enable the Reverse Printing option for alternating lines. 

Reverse Printing causes the machine to begin marking at the end of the selected entity and 

move toward the beginning. 
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To optimize marking machine efficiency: 

• Enable Reverse Printing on every other line of text. 

• Alternate this setting for each consecutive line. 

Proper use of this feature improves readability and reduces unnecessary axis travel. 

NOTE: REVERSE PRINTING ON SOME MACHINES CAUSE A SMALL DOT TO APPEAR 

BETWEEN WORDS.  

Text Properties 

Once a text entity has been inserted into the layout, its properties can be modified. 

When a text entity is selected in the layout window, the ribbon automatically updates to display 

the properties specific to that entity. 

Editable Properties 

The following text properties may be adjusted: 

• Size 

• Angle 

• Orientation 

• Font Type 

 

 

Adjustments made in the ribbon are reflected immediately in the layout window.  
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Accessing the Properties Panel 

Text properties may also be accessed through the Properties panel. 

To open the Properties panel: 

1. Select the text entity in the layout. 

2. Select the Help tab. 

3. Click Properties. 

A properties window will appear in the lower-right corner of the application workspace. 

Scroll within this panel to view all available entity parameters. Double-click a property field to 

modify its value. 

 

Columbia Marking Tools recommends adjusting text properties through the ribbon interface 

unless advanced configuration is required. 
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Editing Text Content 

To edit the content of a text entity: 

1. Double-click the text entity in the layout. 

2. The Text Editor dialog window will open. 

3. Modify the text as required. 

4. Select Accept to apply changes. 

Input field           Preview Field                     Hyperlinks 

 

 

 

 

 

 

 

 

Fixed and Dynamic Text 

The Text Editor supports both fixed and dynamic text. 

• Fixed Text – Static content that does not change (e.g., part name, model number). 

• Dynamic Text – Automatically updating content (e.g., counter, date, time). 

A single text string may contain: 

• Fixed text 

• Dynamic text 

• A combination of fixed and dynamic elements 

Dynamic elements update according to system configuration at the time of marking. 
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Interface Flexibility 

Most functions within the I-Mark software can be accessed in multiple ways, including: 

• Ribbon icons 

• Side panels 

• Right-click shortcut menus 

Regardless of the method used, changes apply directly to the selected entity. 

Wild Cards 

A Wild Card is CMT’s term for dynamic text—text elements that automatically change based on 

system data. 

The following example demonstrates how a Wild Card can be used within a text string that 

combines fixed text with dynamic (Wild Card) elements. 

You will notice that once you enter text into the input field it will also appear in the preview 

window – a helpful feature to further your understanding and comprehension of the text you are 

placing.  

Creating a Dynamic Date String 

To create a text string that displays the current system date (mm/dd/yyyy), follow these steps: 

Procedure 

1. In the Layout Ribbon tab, select the Text icon to insert a text entity into your layout. 

2. Double-click the text entity to open the Text Editor window. 

3. Type any fixed text in the editor. Example: 

Date  

4. Insert Wild Cards using the list of options in the Text Editor window, or type the 

corresponding code directly at the top of the editor: 
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o Month (2-Digit): %m 

o Day of Month (2-Digit): %d 

o Year (4-Digit): %Y 

5. Add forward slashes / as needed to format the date: 

Example sequence: Date %m/%d/%Y 

6. Click Accept to save the text string. 

The text entity will now display in the layout according to the settings of the layout (position, font, 

size, orientation). The preview window reflects the final appearance. 

Important: Wild Card codes are case-sensitive. Ensure correct case to generate the proper 

value. 

Make sure to click “Accept” before exiting. 

Quick tip! If you want to quickly edit your already written text click on the entity, to open the 

entity ribbon, there you will find a section called text, and right above the font selector, you can 

click on your text to quickly edit – without opening the larger window dialog box. 

Congratulations you have just written a dynamic text, now we can edit our text  

Character Size 

Methods of Adjustment 

1. Manual Resizing 

• Select the text entity in the layout. 

• Use the corner arrows to drag the text to the desired size. 

This method behaves similarly to resizing text in other standard software programs. 

2. Numeric Entry 

• In the Entity Ribbon, navigate to the Text section. 

• Enter the desired character height in inches. 
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Note: When adjusting character height numerically, the character width automatically updates to 

maintain the original aspect ratio of the text. This also occurs when resizing manually using the 

corner arrows. 

 

Separation Control 

Separation adjusts the spacing between individual characters in a text entity. 

• Enter the desired separation value in the Entity Ribbon. 

• Separation ensures 

precise control over text 

appearance in your mark. 

Important: Unlike character size, 

separation cannot be adjusted 

manually by dragging; it must be 

set numerically in the ribbon. 

Angular Text 

 Creating Angular Text 

Angular text allows you to rotate or slant a text entity within the layout to a specified angle. 

Procedure 

1. Select the text entity in the layout. 

2. The Entity Ribbon will update to display properties for the selected entity on the Entity 

Tab. 

3. In the angle dialog box, enter the desired rotation or slant angle. 

4. Press Enter or click outside the box to apply the change. 

The text entity in the layout will update immediately to reflect the new angle. 

Radius Text 
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Radial text allows a text entity to follow a circular path for marking in a curved pattern. 

Procedure 

1. Select the text entity in the layout. 

2. The Entity Ribbon will update to display 

properties for the selected entity. 

3. Locate the Radius property. 

4. Enter the desired radius value. 

5. Press Enter or click outside the field to apply 

the change. 

QUICK TIP: FOR PER APPLIED RADIUS OF 0.5000 

CLICK STYLE THEN SELECT CLOCKWISE OR 

COUNTER-CLOCKWISE DEPENDING ON WHERE 

YOU WANT YOU TEXT TO FOCUS.  

The text entity will update immediately in the layout to reflect the specified radius. 

Graphics 

I-Mark software allows graphics or logos to be added to a marking layout. 

Graphics provide additional identification capability and expanded marking flexibility. 

 

Inserting a Graphic Entity 

1. Select the Layout Ribbon tab. 

2. Click Graphic. 

A graphic placeholder will appear in the layout window. The 

placeholder is displayed as a red box with a cross and the text: 
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“No Graphic Selection”  

This indicates that a graphic has not yet been assigned to 

the entity. 

3. Double click on the graphic placeholder in the layout. 

A list will appear showing: 

• System preloaded graphics 

• Previously imported graphics 

Select the desired graphic from the list.  

 

Importing a DXF Graphic 

Graphics must be in DXF format before 

importing. 

Ensure your DXF file is prepared and saved 

correctly prior to beginning the import 

process. 

Procedure: 

1. Select the File tab above the ribbon. 

2. Select Import. 

3. From the submenu, select Import DXF Graphic. 

4. Browse to and select the desired DXF file. 

5. Go to the Layout ribbon, and select Add New Graphic Entity. 

6. Then, in the Entity ribbon, go to Select Graphic Function, and click the down arrow to 

show all available graphics. 

7. From this list, select the graphic you wish to display. 
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8. Notice: Just like any other entity, you will have to teach the machine the position. Go 

to the Teach Position section for instructions. 

Optional – Using a Graphic as a Template: 

If you wish to show your graphic as a template, deselect it from the marking order. It will 

appear grey on the screen and will not be marked on your part. 

Warning: Once deselected, the graphic is locked on the layout and cannot be moved until 

you reselect it. 

Notice: 

• The graphic of the template should be made to scale if not already done so. To verify, 

we recommend doing a trial run to see if the graphic’s text matches the placement you 

want on the material you are marking. 

Quick Troubleshoot: 

• Use a simple graphic for testing. Complex graphics may cause system errors. 

If you have an issue importing a graphic, it could be because your graphic is too busy or the 

text is too small. To fix this: 

1. Clean the file of any excess “noise.” 

• We recommend cleaning the file of unnecessary noise before importing for the 

cleanest conversion. 

2. Enlarge the graphic within the file for better conversion. 

• If the file still doesn’t work after cleaning, it is likely a text size issue. You must 

blow up / enlarge the graphic to a bigger size. Don’t worry—you can shrink the 

graphic to the correct size later in the i-Mark application. 

 

Saving and Naming the Graphic 

After selecting the DXF file: 

1. Save the graphic to the system library. 
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2. Use the dialog box at the bottom of the window to rename the graphic, if desired. 

Renaming graphics is recommended for easier identification during future use. 

 

Arc Tolerance Setting 

During the import process, you will see an Arc Tolerance setting. 

The default value is 100. 

Arc Tolerance determines how many line segments are used to approximate an arc. 

• Lower tolerance value = more segments (greater detail, smoother arc) 

• Higher tolerance value = fewer segments (simpler arc structure) 

Value range: 1 to 2000 

General guidance: 

• Use higher values for simple graphics. 

• Use lower values for complex graphics requiring higher arc precision. 

Improper tolerance selection may affect graphic smoothness and marking performance. 

Data Matrix and UID Code 

2D Data Matrix codes are widely used for part traceability and permanent identification. 

I-Mark software supports two types of 2D code entities: 

• Data Matrix 

• UID Code 

Both entities encrypt fixed or dynamic data into a machine-readable format. 

 

Inserting a Data Matrix Code 

A Data Matrix entity may be inserted using either method: 



 

Page 43 

 

• Select Data Matrix from the ribbon 

• Drag the Data Matrix icon from the toolbox onto the marking layout 

After insertion, the Data Matrix code will appear in the layout window. 

To preview the encrypted data: 

• Hover the mouse over the Data Matrix code without clicking. 

The encrypted string will be displayed. 

 

Editing Data Matrix Content  

To modify the encoded data: 

1. Double-click the Data Matrix entity in the 

layout. 

2. The Data Matrix Editor window will open. 

The editor is similar in appearance and 

function to the Text Editor. 

3. Enter the desired data. 

You may input: 

o Fixed data (static values) 

o Dynamic data (Wild Cards, 

counters, date, etc.) 

4. Select Accept to apply changes. 

5. Hover the mouse over the Data Matrix 

entity to verify the updated encrypted 

data. The Data Matrix will update 

automatically in the layout. 



 

Page 44 
 

Square Dot Feature (Scribe Units Only) 

I-Mark systems offer a Square Dot marking option for Data Matrix codes. 

Square Dot replaces standard round dot impressions with high-resolution square marks. 

Benefits of Square Dot 

• Improved readability on rough or irregular surfaces 

• Enhanced scanning performance on castings 

• Improved legibility on parts with heavy machining marks  

 

Enabling Square Dot 

1. Select the Data Matrix entity in the layout. 

2. Open the Properties dialog, or the entity tab of the data matrix and click square dot in 

the appearance section.  

3. Locate the Square Dot 

setting. 

4. Select Yes to enable Square 

Dot marking. 

 

Dot Percentage Adjustment 

The Dot Percentage setting controls the relative size of the individual marked elements within 

the Data Matrix. 

• Increase the value to enlarge dot size. 

• Decrease the value to reduce dot size. 

Dot Percentage should be adjusted according to material type, surface finish, and marking 

depth requirements. Improper dot sizing may affect code readability.
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Copy, Cut, Paste, and Delete Functions 

Copy 

The Copy icon is located on the middle left of the Layout Menu 

Ribbon. 

When selected, this command copies all currently selected 

entities to the clipboard without removing them from the layout. 

Using the Paste command after copying will 

create a duplicate set of the selected entities. The paste command may be used 

repeatedly to create multiple duplicate sets. 

Paste 

 The Paste icon is located on the middle left of the Layout Menu Ribbon. 

When selected, this command inserts into the currently open layout any entities that 

have been copied or cut to the clipboard. Each use of the paste command creates 

an additional set of the clipboard contents 

Cut 

The Cut icon is also located on the middle left of the Layout Menu Ribbon. 

When selected, this command removes all currently selected entities from the 

layout and copies them to the clipboard.  

Delete 

The Delete command is available in two locations: 

• In the Marking Order Window 

• On the middle left side of the Layout Menu Ribbon 

Both icons perform the same function. 
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When selected, this command permanently deletes all currently selected entities from the open 

layout. Deleted entities are those outlined in blue in the Main Work Area or highlighted in the 

Marking Order Window. 

In addition, pressing the Delete key on the keyboard performs the same action. 

The Marking Order Window serves as a legend displaying the position and style of all entities to 

be marked. 
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Display Settings – View Ribbon 

Zoom Features 

The Zoom features are controlled through four icons on the far left of the View Menu in the 

Ribbon. 

The icon zoom in to a smaller area of the layout file on the screen.  

The Actual icon will reflect the actual size of the mark. If used with 

pen options, it will help determine how close lines and character will 

be on the final product.  

The out icon will zoom out to show more of the layout file on the screen.  

The Fit icon will automatically display the entire marking field in the Main Work Area.  

  

Grid/Rulers 

Grid Lines: Check box for on. Internal grid lines go through the layout. area. Grid lines are 

shown every inch, or 5 millimeters. 

 

Rulers: Check box for on. Rulers run 

along the top and left of the layout 

screen. They display inches or 

Millimeters depending on the units. 

 

Axis Labels: Check Box for on. Specifies X,Y axis and motion type (linear, rotational), and Units. 

 

 Home Position*: Check Box for on. Home position is labeled with two intersecting green lines 

with arrows. 
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* Home position is defined as the maximum X and the Zero Y. This is the position that the 

marker is defaulted to start each cycle from. 

 

Units: English or Metric. Select system through drop down menu. If In is shown the units are in 

Inches. If MM is shown the units are in millimeters. 
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Object Placeholders 

Overview 

Object Placeholders are dynamic wildcards used within text entities to automatically insert 

variable data at the time of marking. Unlike static text, placeholders allow the marking system to 

retrieve live values from external devices or internal controller registers, enabling automated 

serialization, traceability, and real-time data integration. 

Placeholders are located in the Other Codes section and are embedded directly into a text 

string. During a marking cycle, the software resolves the placeholder and replaces it with the 

current value from its assigned source. 

 

Purpose of Object Placeholders 

Object Placeholders are used to: 

• Eliminate manual text edits between marking cycles 

• Automatically mark changing data such as serial numbers, batch IDs, or production 

values 

• Enable integration with PLCs, scanners, databases, or networked control systems 

• Support traceability and compliance requirements 

• Reduce operator error and improve marking consistency 

 

Placeholder Syntax 

There are two types of Object Placeholders, distinguished by capitalization: 

Placeholder Type Data Source 

%p# Placeholder Text (lowercase) Modbus / Serial 
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%P# Placeholder Text (uppercase) Register / EtherNet/IP 

 

Note: The # represents the object number assigned to the placeholder. 

 

Type 1: %p# — Placeholder Text (Modbus / Serial) 

Description 

The %p# placeholder retrieves data from Modbus or Serial communication sources. This 

type is typically used when the marking system receives data from legacy equipment, barcode 

readers, serial devices, or external controllers communicating over Modbus or serial protocols. 

Behavior 

• The value is retrieved at runtime, just before or during the marking cycle 

• The placeholder resolves the current value stored in the assigned Modbus or serial object 

• The marked text updates automatically without user interaction 

Common Use Cases 

• Serial numbers provided by an external PLC 

• Lot or batch numbers sent from a production line controller 

• Operator-entered values passed through a serial interface 

• Data from legacy systems without EtherNet/IP capability 

Example 

PART SN: %p1 

If %p1 is mapped to a Modbus register containing A45792, the marked result will be: 

PART SN: A45792 
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Type 2: %P# — Placeholder Text (Register / EtherNet/IP) 

Description 

The %P# placeholder retrieves data from internal registers or EtherNet/IP-connected 

devices. This is the preferred method for modern industrial environments using networked 

PLCs and EtherNet/IP communication. 

Behavior 

• Reads directly from controller registers or EtherNet/IP data tags 

• Supports high-speed, real-time communication 

• Ideal for automated, network-driven marking systems 

Common Use Cases 

• PLC-driven serialization 

• Production counters 

• Shift, station, or line identifiers 

• Automated traceability systems tied to MES or SCADA platforms 

Example 

LOT: %P3 

If register %P3 contains LOT-2026-014, the marked result will be: 

LOT: LOT-2026-014 
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Key Differences Between %p# and %P# 

Feature %p# %P# 

Capitalization Lowercase p Uppercase P 

Communication Type Modbus / Serial Register / EtherNet/IP 

Typical Environment Legacy or serial-based systems Modern networked systems 

Data Source External device PLC or controller register 

Important: Capitalization matters. %p1 and %P1 are treated as entirely different placeholders. 

 

Using Object Placeholders in a Layout 

1. Create or select a Text Entity in the layout 

2. Enter static text as needed 

3. Insert the placeholder code (%p# or %P#) at the desired position 

4. Download the layout to the controller 

5. Ensure the placeholder object is properly configured and mapped 

At runtime, the software automatically replaces the placeholder with its current value. 

 

Best Practices 

• Always verify placeholder mappings before running a Start cycle 

• Perform a Trial Run to confirm positioning and formatting 

• Use clear naming conventions for placeholder object numbers 

• Avoid mixing placeholder types unless required by the system architecture 

• Document placeholder usage for maintenance and troubleshooting 
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Summary 

Object Placeholders allow I-Mark software to dynamically insert live data into marking layouts. 

By using %p# for Modbus/Serial communication and %P# for Register/EtherNet/IP 

communication, operators can create flexible, automated, and scalable marking solutions that 

support modern manufacturing traceability requirements. 
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Setting Up Counter 

Setting Up Counters  

 

Counters in I-Mark software allow automatic numbering of parts or 

products, useful for serialization, batch tracking, or production 

counts. 

 

Access the Counter Settings 

1. On the Ribbon menu, select your active machine. 

2. The Counters dialog will appear. 

 

Configuring a Counter 

 

1. Select the desired counter (e.g., Counter 

0). 

2. Set the parameters according to your 

application requirements. 

 

Important Notes:  

• The Final Number determines how many digits the counter will use. 

o Example: Final Number = 99999 → five digits. 

• Maximum value = 99999. After reaching this value, the counter will reset. 

• Additional reset conditions are available depending on your application. 
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Using Counters in Text Entities 

1. Insert the counter into your text string using the counter code: 

%C1  → Counter 1 

%C2  → Counter 2 

%C3  → Counter 3 

2. Place the counter code anywhere in your 

text entity. 

3. Multiple counters can be used in the 

same layout or across different 

programs. 

Ensure counters are uniquely assigned per program/layout to prevent unintended overlap. 

 

Viewing and Overriding Counter Values 

1. Navigate to the Diagnostics tab on the 

left side of the controller page. 

2. Select the Counters tab. 

3. Here you can: 

o View of current counter values 

o Manually override any counter as 

needed 

 

Operational Notes 

• Counters automatically increase according to the programmed layout. 

• Ensure the correct counter number is used in the text entity to match your setup. 

• Use the diagnostics view to monitor and adjust counters during production. This allows 

precise control of serialized marking and ensures repeatable, traceable outputs.



 

Page 56 
 

Setting Up Shifts  

Setting Up Shifts 

I-Mark software allows production shifts to be tracked and 

printed directly on parts. Shifts can be added, named, and 

linked to layouts using a dynamic code.  

 

Accessing the Shifts Dialog 

1. Let the software fully open. 

2. On the Ribbon menu, select the Shifts tab. 

3. The Shifts dialog box will open. 

 

Adding a New Shift 

1. Click Add to create a new shift.  

2. The Edit Shift box will appear. Configure 

the following: 

o Shift Name: Name your shift. 

▪ Note: The shift name will print on the part. 

o Shift Start Time: Enter the start time for the shift. 

3. Repeat as needed to add additional shifts. You may use as many shifts as you would 

like.  

4. Using the shift wildcard will enter appropriate shift in mark.  
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Using Shifts in Your Layout 

1. Create your text entity in the layout. 

2. Insert the shift code %S wherever 

you want the shift name to appear. 

 

The software will automatically determine 

the active shift based on the system allocated time and print the corresponding shift name 

during marking. 

 

Downloading Shift Settings to the Controller 

1. Navigate to the Controller Page. 

2. Click Download to save the layout and shift settings to the controller. 
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3. Once downloaded, the software will reference the time you allocated for each shift and 

automatically apply the correct shift during production. 

 

Best Practices 

• Ensure the system’s time matches your actual production schedule. 

• Use meaningful shift names that make sense when printed on parts. 

• Always download the layout after creating or modifying shifts to ensure proper 

synchronization. 

• Verify the %S code is correctly placed in your text entities before marking. 
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Using the Rotator  

 

Creating a layout with the Rotator enabled. 

From the “Home” Menu select the “Create New Layout” button in the software. 

 

On the “Create Layout” dialog choose your marker type from the list on the left and then on the 

right side of the screen. Choose the Axis configuration whose Axis in Parenthesis contain X and 

A. 
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NOTE: The axis within the parenthesis will be the two designated axis used for the drawing of 

the layout. All additional axis listed in the configuration will be available as positional axis only. 

 

After you’ve selected a configuration, whose axis is a rotary type (A in this case), the dia- log will 

show a hidden field for the Part Diameter. This data in this field must be entered correctly to 

ensure that the scaling of the marking around the circumference of the part is accurate. 

 

NOTE: If your part has multiple surfaces with 

varying diameters, the diameter at or closest to 

the desired marking location should be entered 

here. 
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This is how the layout form will look if you’ve entered the same values I have in this example. 

Horizontally is the X-axis and the vertical axis of this 2D layout is the A-axis. Its dimensions 

were calculated off the know X-axis travel distance of 4” and the calculated value of the part 

circumference (diameter [1.25] x π) = 3.9267 or roughly a 4x4 grid. 

 

The bottom horizontal line of the grid represents the Apex of your part or the 12 o’clock position. 

This position must be taught for the Y-axis to ensure that the program will begin marking directly 

over top of the part.  

Start by adding a text entity to your part. The program will drop the text automatically into the 

center of the layout grid. 

 

Now located along the bottom of your software window is a tab named “Manual”. Move your 

cursor overtop of this tab to enable it to slide-out. This tab will allow us to jog the physical axis 

on the machine in order to teach the current position of the mark- ing axis to the text or any 

other desired entities in the program. 
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Jog the X-axis → until the marking pin is over top 

of the marking area you’re desiring to mark. Then 

jog the Y-axis ↓ to bring the pin directly overtop at 

the Apex or 12 o’clock position of the part. 

 

Then when the pin is directly over top of the 

desired marking surface, select your text entity tab on the marking layout and right-click on it to 

show the context menu. 

Select “Teach → All Positions”. 

After setting the position of the text to 

be equal to the current position of the 

marking axis, you’ll see that the text 

on the grid has moved to the relative 

position of the axis. 

 

The current position is X = .7800, Y = 

1.3248, A = 0.000 

With the text in this current orientation 

moving horizontally, the marking head 
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will rotate the part only slightly to draw the vertical motions of the character Height and the X- 

axis will move to draw the horizontal motions of the character Width. This will result in the 

marking along the part as such. 

 

If you flip the orientation of the text entity to be written vertically as shown here then the marking 

will occur around the part using the A-Axis for the majority of the motion drawing the horizontal 

movement of the character Width and the X-axis will move small motions drawing the vertical 

height of the character Height. 

The resulting mark from this orientation will be as such. Finally to do multiple text entities, just 

ensure that each one following the initial has the exact same Y-axis coordinate to make sure 

that the pin stays directly over top of the part.  
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Communications  

Setup I-Mark for Ethernet/IP Communication 

Step 1: Controller Setup 

When the EtherNet/IP Mode has been activated, the I-Mark Controller will be constantly 

monitoring a Control Register which allows you to remotely control the marking machine over 

EtherNet/IP. Similarly, the I-Mark controller will be updating a local Register at a very high rate 

with a Bitwise Value of the Machine’s status. The I-Mark software contains a dialog which allows 

the user to map what standard controller functions you’d like to the available bits within the 

Control and Status Bytes. 

The following is an instructional document which will help you in setting up the I-Mark controller 

for EtherNet/IP Mode. 

 

Once connected to the controller through the I-Mark Software, the controller will show up under 

the Navigation pane on the lower left side of the software. You can double click on controller 

listed in here or if you select it, the Ribbon menu across the top will change to this controller 

specifically and you can select “Open Marking Machine”. With this screen you can modify the 

parameters of the machine as well as get the full status and live feed of what the machine is 

doing. 

 

1. With the ribbon still highlighted on your 

controller page, there is an icon which looks 

like a Green and Red arrow opposing each 

other…. 

 

This button will open a dialog to allow you to 

configure the I/O’s of this controller. 
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This dialog will allow you to map the function listed to the left with the desired I/O index number 

and medium you would like to control it with. So for your configuration, you are going to go 

through each of these items and change their “Type” to Ethernet/IP and then make sure the 

index number below it is unique. 

A basic setup should look like this chart here. 

 

Inputs  Outputs  

Start EtherNetIP: 

0 

Bit 1 Ready EtherNetIP: 0 Bit 1 

Reset EtherNetIP: 

1 

Bit 2 Marking EtherNetIP: 1 Bit 2 

Program Select 

1 

EtherNetIP: 

2 

Bit 4 Completed EtherNetIP: 2 Bit 4 

Program Select 

2 

EtherNetIP: 

3 

Bit 8 Fault EtherNetIP: 3 Bit 8 

Program Select 

3 

EtherNetIP: 

4 

Bit 16    

Program Select 

4 

EtherNetIP: 

5 

Bit 32    

Program Select 

5 

EtherNetIP: 

6 

Bit 64    

  

1. Once you’ve configured it to be this way, press OK to apply and save this configuration to 

the workspace. 

 

Step 2: Create a Layout with EtherNet/IP placeholder 

1. Go back to the Home tab and click “Create New Layout”. It will ask you what type of machine 

you want to create a layout for, if you’re directly connected to the machine there will only be 

1 listed there (IM_ID60) just select this and click OK. 

2. Now you can see the Layout which appears to look like a grid, this is the 

physical marking window for the machine. To add a new text object which will 

print data received from the PLC over Ethernet/IP, click on the “Layout” tab at 

the top and single click on the button which says “Text”. 
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This button will drop a text entity into the center of the layout which reads simply “Text”. You 

modify this entity by double clicking on it which opens up a new dialog for editing the text entity. 

Delete the sample “Text” in the top field and then look down at the different codes available for 

dynamic data. One of the codes is labeled “Placeholder Text (Register/Ethernet/IP)”. You can 

click directly on this text or type in %p0 to the Text to Mark field as shown here. 

 

Now press Accept to apply the change to the Text entity. The text within the layout will say 

“Global Register Text 0" as this is just a simulation to illustrate that we are waiting for data to 

appear in order to mark it here because the register at this time is empty. 

 

Step 3: Assign Layout to the controller. 

 

1. Click directly on the layout to activate the layout tab on the ribbon, 
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2. Click on the button labeled "Assign to Machine" 

• Click on the machine listed below this button which 

corresponds to the name of the machine you're currently 

working with. This will assign the currently layout to this 

machine so when a download occurs it will synchronize. 

3. Save the Layout by going to the "Home" tab and select "Save Layout"  

Step 4: Set Layout as active layout for marking. 

 

1. Click the tab on the toolbar named after the controller you are working on. On this 

ribbon will be a button called "Layouts" click it  

• Clicking this button will open up a dialog for you to assign layouts to a specific 

binary assignment. Set the layout you just created as the 

 

Step 5: Save and download the configuration to the controller. 
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1. Navigate to the Setup and Control tab within the Controller Page. 

 

 

2. Click on the Download button to save all of your Layouts and configuration to the 

controller’s memory. 

 

3. After the progress is completed, you may now disconnect from I-Mark 

 

 

Controlling I-Mark over EtherNet/IP 

Input Control Register: 

To execute the function assigned to the binary index, perform a bitwise calculation and enter the 

Sum of the binary values into the Input Control Register. The next time this register is polled by 

the controller for its value, the controller will execute the command(s) requested. 

Example: To tell the controller to "Start" marking, write the value of 1 to the Input Control 

Register. Then when the register is polled for its value, the controller will initiate the marking 

sequence for the layout assigned to "0" in the previous section. 
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Example 2: If you have assigned multiple layouts to Select Number using the Layouts dialog, 

put the value of 1 for "Start" command plus the value of 4 for the Select 1 command. So the 

Input Control Register will have the integer number 5 commanding the marker to Start marking 

using Select 1. 

Each time I-Mark receives a new value, the controller will clear the previous out first before 

writing the new value into it. If the Control Register still contains the "Start" command after the 

marking is completed, the marking head will not return to home until the start bit is = 0. 

 

Output Register: 

The Output Control Register will function in a similar manner to the Input Control Register. The 

marking controller will provide a status in the form of a Bitwise value which will be read by the 

PLC for current marker status. Like the Input Control Register, the output will likewise be 

updated at a frequency of 1ms depending on the current process being executed on the I-Mark 

Controller. 

Example: Using the chart above, when the marking controller is in a Ready state, the first byte 

be equal to the value of 1. Similarly, if there is a fault within the marking controller, the value of 8 

will be present in the Output Control register. 

 

Writing Marking Data to the I-

Mark Controller: 

The I-Mark controller will accept 

ASCII integer values in specified 

placeholder registers to be used 

as marking data for your layout. 

These registers are global, 

which allows them to be used in 

multiple layouts without outside 

intervention. The I-Mark memory 

Placeholder  

%p0 Register. 300-319 Placeholder 0 

%p1 Register. 320-339 Placeholder 1 

%p2 Register. 340-359 Placeholder 2 

%p3 Register. 360-379 Placeholder 3 

%p4 Register. 380-399 Placeholder 4 

%p5 Register. 400-419 Placeholder 5 

%p6 Register. 420-439 Placeholder 6 

%p7 Register. 440-459 Placeholder 7 

%p8 Register. 460-479 Placeholder 8 

%p9 Register. 480-499 Placeholder 9 
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utilized 32-bit integer registers to hold this marking data similar to the Input and Output Control 

Registers. Within the I-Mark software itself you can create an entity known as a "Placeholder" 

which will utilize this local data to be marked within the layout. The place holder is capable of a 

maximum 80 characters of information with each character using 8 bits or 1 byte of data. 

Remembering that our registers can hold 32-bits of information, each placeholder would occupy 

a total of 20 Integer Registers for holding that data. The I-Mark software allocates these Integer 

Registers for the assigned placeholders in the follow locations. 

 

Once the layout which utilizes any of these registers is executed, the I-Mark controller will look 

at the value of the corresponding register and print what was found within it. If a register is 

programmed within a layout but does not contain any data, there will be a corresponding error 

message within the controller producing a Fault (Output Control Register Bit. 
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Marking Machine Menu  

Controller Download 

This icon is located in the Marking Machine Menu Ribbon. This ribbon is only available when a 

marking machine is opened in the Main Work Area. When selected this 

command will update all the layouts assigned to the controller with the most 

recent saved layouts on the PC. 

  

While a number of marking machines may be opened, the selected machine will be the 

associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system 

will be highlighted and opened in the Main Work Area.    

  

Files on the controller may also be updated by dragging and dropping in the Navigation Window. 

  

In addition, a layout file on the controller may be edited directly in the controller. This is 

accomplished by double clicking on the layout file associated with the marking machine in the 

Navigation Window.  

Controller Upload 

This icon is located in the Marking Machine Menu Ribbon. This ribbon is only 

available when a marking machine is opened in the Main Work Area. When 

selected this command will upload all the layouts that reside on the controller to the 

PC.  

  

While a number of marking machines may be opened, the selected machine will be the 

associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system 

will be highlighted and opened in the Main Work Area.    
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Files on the controller may also be updated by dragging and dropping in the Navigation Window. 

  

In addition, a layout  file on the controller may be edited directly in the controller. This is 

accomplished by double clicking on the layout file associated with the marking machine in the 

Navigation Window. 

  Warning messages may appear if the Marking System is set to run a layout file 

that is an earlier revision than the version currently stored on the system. 

Essentially a warning will appear if you have not saved and downloaded your 

newest verison of the selected layout.  

Controller Clock 

This icon is located on the Marking Machine Menu Ribbon. This ribbon is visible once a marking 

machine has been selected in the navigation window, and is opened in the Main 

Work Area. When selected this command will synchronize the clock on the 

selected marking machine to match the PC clock. 

  

While a number of marking machines may be opened, the selected machine will be the 

associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system 

will be highlighted and opened in the Main Work Area.    

Assigning Layout to Marking Machine 

This icon is located in the Marking Machine Ribbon. This ribbon is visible once a 

marking machine has been selected in the navigation window, and is opened in the 

Main Work Area.  
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While a number of marking machines may be opened, the selected machine will be the 

associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system 

will be highlighted and opened in the Main Work Area.    

  

A drop-down menu will appear and display all additional layouts from the PC available to be 

assigned to the machine. 

  

• The layout must reside in the I-Mark data directory located: ...Program 

Files\I_Mark_x_x_x  (where the small "x"s are the version numbers). 

• The layout must have the same marking machine type as the marking machine selected. 

If a required layout does not appear check the layouts location on the PC, and the marking 

machine type assigned to it. 

  

In addition to the Assign Layout icon, I-Mark software also allows for a "drag and drop" method 

to assign layout to marking machines. This is done by using the navigation window. Click on the 

layout required and "drag" to the marking machine. 

If this symbol continues to appear when you drag layout over marking machine, 

check to make sure that the layout machine type matches the marking machine type 

of the desired machine. 

Counter Configuration 

This counter configuration icon is located on the Marking Machine Menu Ribbon. 

This ribbon is only available when a marking machine is opened and selected in 

the Main Work Area.  
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While a number of marking machines may be opened, the selected machine will be the 

associated with the name on the Marking Machine Menu Ribbon Tab. In addition, this system 

will be highlighted and opened in the Main Work Area.    

  

When selected the following configuration widow appears. 

 

Counter List: List of counters in the marking machine. 

 Increment: Value the counter changes each time the machine is cycled. 

 Final: the value at which the counter will stop. 

 Reset: The number which the counter will reset to  
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Reset Condition: If  set to NONE, the counter will not reset. If set to FINAL, the counter will reset 

when it reaches the final value. If set to DAILY, the counter will reset at the end of each day. If 

set to  END OF SHIFT, the counter will reset at the end of each shift. This command is paired 

with the Shift configuration. 

  

When INPUT is select as a reset condition additional fields will display. 

Input: Requires a I/O number form 1 through 7, and relates to the I/O position in the Controller. 

Input Level: This option is specified as either low or high. 

 

 

Additional information about the counters in the marking machine is located on the Status & 

Control Tab of the marking machine in the Main Work Area. 

Currently the standard counter does NOT have the functionality for counting down, having 

negative values, or numeric type other than integers. 
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Programing Your Marking - Marking Specifics 

Congratulations by this section you should have the Layout with the mark you are about to 

make.  

Teaching Your Machine 

 Teaching the Machine (Setting the Marking Position) 

Teaching the machine establishes the relationship between the marking layout (software) and 

the physical part positioned under the marking head. The layout represents the machine’s 

printable area—not the actual part. Teaching synchronizes the layout coordinates with the real-

world X and Y motor positions so the mark is placed correctly on the material. 

 

Preparation 

1. Ensure your layout is open and all required entities (text, logos, etc.) are placed in the 

layout. 

2. Each entity displays a green reference point: 

o Bottom-left corner by default. 

o Center point if the center function was used. 

This reference point determines the entity’s position on the material. If the green  

reference point is located at the center of the entity, and the marking head is taught to that 

location, the center of the entity will be placed at that exact position on the material. 

By default, marking starts from the bottom-left corner of the entity unless otherwise configured. 
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Manual Teaching Procedure 

1. Open Manual Control 

1. Double-click the entity in the layout to activate the Entity tab in the ribbon. 

2. Click the Teach icon. 

3. From the dropdown menu, select Manual Control. 

This opens the manual jogging controls for the marking head, using the arrows.  

 

 

2. Jog the Marking Head to the Desired Location 

Using the X and Y axis controls: 

1. Jog the X-axis until the marking pin is positioned over the desired starting point on the 

part. 

2. Jog the Y-axis to align vertically with the intended marking location. 
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Continue adjusting until the marking pin is precisely positioned where the first character (bottom-

left reference point) should begin on the part. 

 

3. Apply the Taught Position 

Once the marking head is correctly positioned: 

1. Return to the Entity tab. 

2. Click the Teach icon again. 

3. Select All Positions from the dropdown 

menu. 

This action: 

• Captures the current X-Y motor position. 

• Updates the entity’s position within the layout. 

• Synchronizes the layout coordinates with the physical part location. 

You will see the entity shift within the layout grid to reflect its newly taught position. 

 

Result 

The entity is now properly aligned between: 

• The layout coordinate system (software) 

• The machine’s motor positions (hardware) 

• The physical part on the fixture 

When the marking cycle runs, the text or entity will begin at the taught location on the material. 

 

Key Notes 
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• The layout is a representation of the printable field—not the physical part. 

• The reference point sets where the entity will appear on the material, with the green point 

marking the entity’s reference point.  

• Always verify part placement before teaching. 

• If the part or fixture position changes, the entity must be re-taught. 

This process ensures accurate and repeatable marking placement. 

 

Adjusting Speed 

 Setting Global and Entity-Specific Speeds 

The I-Mark software allows different marking speeds to be assigned to individual entities within 

a layout. This feature enables optimization of both cycle time and mark quality. 

For example, in a layout containing standard text and a 2D Data Matrix code: 

• Text can be marked at a higher speed to reduce cycle time. 

• The Data Matrix can be marked at a lower speed to improve clarity and scanner 

readability. 

 

Global Speed 

The Global Speed defines the default marking speed for the entire layout. 

All entities will run at this speed unless an entity-specific speed is applied. 

To Set the Global Speed 

1. Click on the layout background (not on an entity). 

2. Access the speed setting in the layout properties. 

3. Adjust the speed value as required. 

This speed will apply to all entities that have the Global option enabled. 
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Entity-Specific Speed 

An entity-specific speed overrides the Global Speed for that particular object. 

To Set a Speed for a Specific 

Entity 

1. Select the desired entity in 

the layout. 

2. Open the Settings tab in the Ribbon menu. 

3. Uncheck the Global option. 

4. Enter the required speed value. 

The selected entity will now operate at the specified speed while other entities continue to follow 

the Global Speed (unless individually overridden). 

 

Entity Dwell 

The Entity Dwell property adds a controlled pause after each movement while drawing a 

character. This can be adjusted in the properties function of the I-Mark software.  

 

Purpose of Entity Dwell 

This setting is useful when: 

• Operating at high marking speeds. 

• Portions of characters appear incomplete. 

• Mark quality begins to degrade due to insufficient pin impact 

time. 

By increasing dwell: 
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• The marking head pauses briefly after each movement. 

• Character definition improves. 

• Mark consistency is enhanced. 

 

Operational Considerations 

• Use higher speeds for simple text to reduce cycle time. 

• Use lower speeds for complex geometries (e.g., 2D Data Matrix codes). 

• Increase dwell if characters appear light, broken, or inconsistent. 

• Avoid excessive dwelling, as it will increase total cycle time. 

Proper use of Global Speed, Entity-Specific Speed, and Entity Dwell allows optimization of both 

productivity and marking quality. 

Download and Save 

Downloading and Saving the Layout to the Controller 

After defining all marking parameters—such as coordinates and speed—the layout must be 

downloaded to the controller before production marking begins. 

Although live streaming is possible from the active marking window, it is best practice to 

download and save the layout to the controller to ensure stability and repeatability. 

 

Access the Controller Page 

1. Select your machine in the Navigation 

pane. 

2. Open the active controller window. 

In the Navigation pane: 

• A green check mark indicates the layout 
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and controller are synchronized. 

• A red X indicates changes have not yet been downloaded.  

 

Download and Save the Layout 

1. From the controller page, click the Download button. 

2. The system will prompt: 

o “Do you want to save all fields before downloading?” 

3. Select Yes. 

This ensures that: 

• Speed settings 

• Taught coordinates 

• Entity-specific parameters 

are saved prior to transfer. 

 

Rename and Save the Layout 

After confirming the save: 

1. A Save Layout As dialog will appear. 

2. Enter the desired layout name. 

3. Click Save. 

The layout will now begin downloading to the controller memory. 

 

Download Process and Status Indicators 

During the download: 
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• The marking window status will display Not Initialized. 

• The controller transfers the layout and configuration data. 

• After completion, the machine will perform a home routine. 

Once complete: 

• The status banner will display Ready. 

• The Navigation pane will show a green check mark next to both: 

o The layout 

o The machine 

This confirms that: 

• The layout was successfully downloaded. 

• The controller and software are synchronized. 

• The system is ready for marking operations. 

 

Best Practice 

Always download and save the layout before production marking to ensure: 

• Correct parameter retention 

• Proper controller synchronization 

• Reliable machine operation 

Consequently, your I-Mark should automatically prompt you to save your layout. 
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Preparing Your Hardware for Your Software 

Before executing a mark, it is essential to verify that your hardware is properly prepared. Even 

with perfectly configured software, improperly set up hardware will compromise mark quality. 

Columbia Marking Tools (CMT) requires marks to meet high standards, so taking the time to 

ready your machine ensures accuracy, consistency, and machine longevity. 

1. Perform a Trial Run 

CMT strongly recommends performing a trial run prior to marking actual parts. A trial run is 

identical to a standard marking operation, except the marking tip is not engaged. 

Benefits of a trial run: 

• Confirms the placement and alignment of your mark on the part. 

• Verifies that the motor parameters do not reach their operational limits. 

• Identifies potential mechanical or alignment issues before committing to production. 

Procedure: 

1. Ensure the layout and entities are correctly configured in your software. 

2. Run the layout in trial mode. 

3. Observe the machine movement and verify the X/Y positions align with your intended 

mark location. 

 

2. Confirm Machine Settings and Status 

Before marking, verify the following: 

1. PSI Settings: Ensure the air pressure (PSI) matches the specifications for your machine 

and marking tip. Incorrect PSI can cause inconsistent marks or premature wear on the 

marking tip. 

2. Power Status: Confirm that the machine is powered on and operational. 
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3. Machine Selection: Verify that the correct machine is selected in the software, 

especially if multiple controllers are available on your network. 

4. Maintenance and Care: Check that the machine has been properly maintained 

according to the recommended schedule. This includes cleaning, lubrication, and 

inspection of moving parts and marking tips. 

5. Distance from pin to part: Check in machine specific manual.  

 

3. Additional Recommendations 

• Make sure the part or fixture is securely positioned to prevent movement during marking. 

• If using adjustable fixtures, confirm that they are tightened and locked in place. 

• Keep the work area free of obstructions that could interfere with machine movement. 

• Review entity placement in the software layout to ensure correct orientation and 

alignment with the physical part. 

• Follow all safety procedures and PPE requirements for your specific machine.  
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Performing Your Mark – “Printing” Your Layout 

Once your layout is prepared and your hardware has been verified, it is time to execute a mark 

on your chosen work surface. This section provides step-by-step instructions and safety 

guidance to ensure accurate and safe marking. 

 

1. Save and Download Your Layout 

Before marking, it is critical to save and download your layout: 

1. Download Layout to Controller: 

o From the Controller Page, ensure your desired layout exists on the controller. 

o Downloading a layout saves it to the controller memory, allowing the machine to 

access it for marking. 

2. Save the Workspace: 

o From the File Menu, save your entire workspace. This ensures that all layouts, 

settings, and associated files are preserved on the controller. 

o Note: Downloading only saves the selected layout; saving the workspace 

preserves the full set of layouts and machine settings. 

 

2. Select a Layout 

1. In the Manual Marking section of the Controller Page, locate the drop-down menu 

labeled “Choose Layout to Mark.” 

2. Select the layout you wish to run from the list of previously saved or downloaded layouts. 

 

3. Trial Run vs Start Run 



 

Page 87 

 

CMT strongly recommends performing a Trial Run before executing a Start Run, 

especially for new layouts or first-time operations. 

• Trial Run: 

o Executes all programmed machine movements without engaging the marking 

pin. 

o Allows verification of: 

▪ X/Y positioning and alignment 

▪ Travel limits of the marking head 

▪ Programmed entity placement and spacing 

▪ Properly taught machine coordinates 

o No mark is applied to the workpiece. 

• Start Run: 

o Initiates an active marking cycle, applying the programmed mark to the work 

surface. 

o Prior to Start, confirm: 

▪ The workpiece is properly secured using slates, fixtures, and appropriate 

mounting hardware. 

▪ The area is clear of hands, tools, or foreign objects. 

▪ All safety procedures and PPE requirements are in place. 

Optional: If the PC or controller interface is unavailable, a CMT-purchased external Start 

Button can be used to initiate a Start Run. 

 

4. Safety Guidelines 

• Operators must wear approved eye protection and other required PPE. 

• Only trained and authorized personnel should operate the machine. 
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• Hands, fingers, tools, or any foreign objects must never be placed inside the machine 

during active operation. 

• All work holding, fixtures, and T-nuts must be properly secured. 

• Follow all facility-specific and operational safety procedures. 

Responsibility Statement: 

Operators are fully responsible for safe machine use. The manufacturer is not liable for injuries, 

equipment damage, or lost production due to: 

• Misuse of the equipment 

• Unauthorized modification 

• Inadequate training 

• Failure to follow documented procedures 

 

5. Handling Errors or Aborts 

If the mark is not produced as intended, follow these steps: 

1. Abort the Cycle: Use the appropriate control to immediately stop the machine. 

2. Review Settings: Confirm the layout, parameters, and placement are correct. 

3. Perform a Trial Run: Verify that adjustments resolve the issue before restarting the Start 

Run. 

Machine Behavior After Abort: 

• The machine will remain in an aborted state until Home is pressed. 

• Pressing Home: 

o Returns the marking head to the default home position (maximum X, zero Y) 

o Clears any abort or fault conditions 
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Remember 

• Always save and download layouts before marking. 

• Perform a Trial Run before active marking for safety and accuracy. 

• Ensure the workpiece and fixtures are properly secured. 

• Follow all safety procedures and PPE requirements. 

• Abort and troubleshoot immediately if the mark is not correct. 
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FAQ 

I-Mark Software FAQ 

This FAQ addresses common questions about the I-Mark software, including installation, setup, 

operation, communication, and troubleshooting. 

 

1. General & Getting Started 

Q1: What is I-Mark software? 

A: I-Mark is a professional industrial marking software package developed by Columbia 

Marking Tools (CMT). It is used to create, edit, manage, and execute marking layouts for I-

Mark dot-peen and scribe marking systems and serves as the primary control platform for these 

machines. 

 

Q2: What are the minimum system requirements to run I-Mark? 

A: The minimum requirements are: 

• Operating System: Windows® 2000, XP, Server 2003, Vista, or Windows 7 (32-bit only) 

• Processor: Pentium®-class CPU, 1 GHz minimum 

• RAM: 512 MB 

• Video: 65,536-color video card at 1024 × 768 resolution 

• Network: 10/100 T-Base network card 

• Required Windows Components: 

o .NET Framework 4.0 

o Microsoft Visual C++ 8.0 

o Windows Installer 3.1 
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Q3: What is the difference between Basic Mode and Advanced Mode? 

A: When launching I-Mark, you must select an operating mode: 

• Basic Mode: 

o Streamlined interface with essential marking functions 

o Recommended for stand-alone marking machines 

o Displays all available machines on the network 

• Advanced Mode: 

o Intended for system integrators and complex installations 

o Enables the use of Workspaces to group and filter machines 

o Reduces clutter and improves organization in facilities with many controllers 

 

Q4: How do I register my I-Mark software and obtain a permanent license key? 

A: New systems include a 90-day temporary license. To obtain a permanent key: 

1. Connect to your controller, open I-Mark, and navigate to Diagnostics. 

2. Record the 8-character Machine ID. 

3. Complete the online registration form: 

http://www.marking-machines.net/I-MarkRegistration.html 

4. CMT will email a permanent License Key within one business day. 

5. Return to Diagnostics, click Update Key, paste the key, and click Submit. 

 

2. Layouts & Entities 

Q5: How do I create a new marking layout? 

A: 

1. Go to the Home tab and select Create New Layout. 

http://www.marking-machines.net/I-MarkRegistration.html
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2. Choose your machine type from the list. 

3. Do not modify the hardware dimensions (width and height). 

4. Adjust speed or dwell settings as needed. 

5. Select a preset (Draft, Normal, or High Resolution). 

6. Click OK to create the layout. 

 

Q6: What types of content (“Entities”) can be added to a layout? 

A: The following entity types are available from the Layout ribbon: 

• Text – Alphanumeric characters 

• Graphics – Imported logos or drawings (DXF format) 

• Lines – Simple geometric lines 

• Data Matrix – 2D codes for traceability 

• UID Code – Codes compliant with standards such as MIL-STD-130N 

 

Q7: How do I add dynamic text such as dates or serial numbers? 

A: Use Wild Cards (dynamic placeholders) within a text entity: 

• Date: %m/%d/%Y 

o Example: Date %m/%d/%Y → “Date 01/15/2024” 

• Counters: %C1, %C2, %C3 

• Shift Name: %S 

Insert these by double-clicking the text entity and typing the desired code. 

 

Q8: Can I import my company logo? 

A: Yes. Logos must be imported in DXF format. 
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1. Go to File > Import > Import DXF Graphic. 

2. Select the DXF file. 

3. Set the Arc Tolerance (1–2000; lower values increase detail). 

4. Save the graphic to the system library. 

5. In your layout, click Graphic on the Layout ribbon and select the saved graphic. 

Q9: How do I mark text in a circle or at an angle? 

A: 

• Select the text entity. 

• Use the Entity ribbon to adjust: 

o Angle – Rotates the text 

o Radius – Curves the text along a circular path 

 

3. Machine Setup & Operation 

Q10: How do I connect I-Mark to my marking machine? 

A: 

1. Go to the Marking tab. 

2. Click Connect to Marking Machine. 

3. The software will scan the network and connect to the controller. 

4. A green check mark next to the machine ID confirms a successful connection. 

 

Q11: How do I teach the machine where to mark on my part? 

A: 

1. Double-click the entity to be positioned. 

2. Go to the Entity tab and select Teach > Manual Control. 
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3. Use the on-screen jog controls to position the pin. 

4. Return to Teach and select All Positions to update the layout. 

 

Q12: What is the difference between a Trial Run and a Start Run? 

• Trial Run: 

o Simulates the entire marking cycle 

o The pin does not strike the part 

o Used to verify positioning and travel limits 

o Strongly recommended before every Start Run 

• Start Run: 

o Executes the live marking process 

o The pin engages and marks the part 

 

Q13: Why should I download my layout to the controller? 

A: Downloading stores the layout and all settings directly in the controller’s memory. This 

ensures consistent operation even if the PC is disconnected and is considered best practice 

before production. 

 

Q14: How do I adjust marking speed? 

A: 

• Global Speed: Select the layout background and adjust speed. 

• Entity-Specific Speed: 

1. Select the entity 

2. Go to Settings 
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3. Uncheck Global 

4. Enter a custom speed value 

 

Q15: How do I set up a serial number counter? 

A: 

1. Open the Counters dialog from the controller ribbon. 

2. Select a counter and define Start, Final, and Increment values. 

3. Insert the counter placeholder (e.g., %C1) into a text entity. 

4. Download the layout to the controller. 

 

Q16: How do I configure shifts for automatic shift marking? 

A: 

1. Open the Shifts tab. 

2. Click Add, name the shift, and set its start time. 

3. Repeat for all shifts and click Apply. 

4. Insert %S into the text entity. 

5. Download the layout to activate the settings. 

Q: How far should the pin be from the part? What about air pressure? 

A: Set pin-to-part distance to roughly 0.188"–0.250" (3/16"–1/4") and adjust system air 

pressure using the integrated regulator for a clean mark 30 to 60 psi. 

 

4. Communication & External Control 

Q17: Can the I-Mark system be controlled by a PLC? 

A: Yes. The controller supports EtherNet/IP communication. 
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• Configure the controller I/O map for EtherNet/IP. 

• Use uppercase PLC placeholders such as %P0. 

• The PLC writes commands to the Input Control Register and reads status from the 

Output Control Register. 

 

Q18: My machine will not connect. What should I check? 

A: Verify the following: 

1. PC and controller are powered on and on the same network 

2. IP addresses are on the same subnet 

3. Default controller IP is 10.1.10.225 

4. Hardware and software versions are compatible 

 

Q19: Can I start marking without a computer connected? 

A: Yes, using the optional CMT Start Button. 

1. Connect the 25-pin connector to the controller’s Input port. 

2. Assign a layout to Slot 0 in the Layouts dialog. 

3. Download the configuration to the controller. 

4. Pressing the external button will run the assigned layout. 

 

5. Troubleshooting & Maintenance 

Q20: Mark quality is poor or inconsistent. What is the most likely cause? 

A: In most cases, the marking stylus (pin) is worn, chipped, or damaged. Replace the stylus 

according to the maintenance instructions in the manual. 
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Q21: The system shows a “Key Expired” fault. 

A: The 90-day temporary license has expired. Register the software and install a permanent 

license key (see Q4). 

 

Q22: I-Mark displays a “Fatal Error” on startup. How do I fix this? 

A: This is typically caused by a corrupted user database. 

1. Close I-Mark. 

2. Navigate to: 

C:\Users\[username]\AppData\Local\Columbia_Marking_Tools\ 

3. Delete the entire Columbia_Marking_Tools folder. 

4. Restart I-Mark. The database will rebuild automatically. 

 

Q23: How do I back up my layouts? 

A: Two methods are available: 

• File Copy: 

o Copy layout files from 

C:\Users\Public\Documents\I-Mark\Basic 

• Export: 

o Go to File > Export > Layouts 

o Creates a compressed .cmtlx file 

 

Q24: What should I do if a fault code appears? 

A: Refer to the Fault Codes table in the Appendix of the main manual for detailed explanations 

and corrective actions.
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Suggested Integration Sequence 

Three examples of 

integration sequence 

diagrams for I-MARK 

integration: 

Standard Operation – I/O 

use for basic marking cycle.  

Operation with Fault (E-

Stop) and Recovery – 

Sequence including 

emergency stop event and 

system recovery process.  

Operation with Serial Data 

Exchange – Standard 

operation including serial 

communication flow (use 

placeholders where 

necessary).
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I-Mark Series-2 Connections 

 

 

 

 

 

 

 

 

 

 

TABLE 1.0 

ITEM DESCRIPTION TABLE 

A POWER CONNECTOR 1.1 

B ETHERNET CONNECTION 1.2 

C SERIAL DATA PORT 1.3 

D I/O OUTPUT CONNECTION PORT 1.4 

E I/O INPUT CONNECTION PORT 1.5 

F 
AUX. OUTPUT CONNECTOR 

(RESERVED) 
CONTACT FACTORY 

G Z-AXIS CONNECTOR (OPTIONAL) CONTACT FACTORY 

H 
MARKING HEAD INTERFACE 

CONNECTION 
CONTACT FACTORY 

 

 

E D 

B 

A 

G F C 

H 
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TABLE 1.1 POWER CONNECTOR 

PIN CONNECTION 

1 LINE 

2 NEUTRAL 

3 GROUND 

NOTE: The I-Mark Series-2 Controller Requires 

120vac power and may draw up to 7.2a depending on 

the marking head you are controlling. 

 

 

 

 

 

3 

2 1 
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TABLE 1.2 ETHERNET CONNECTION 

PIN DESCRIPTION 

1 
ORANGE PAIR-2 

2 

3 

GREEN PAIR-3 
4 

5 

6 

7 
BROWN PAIR-4 

8 

 

Note: The I-Mark Control can operate using a Static IP address or using DHCP mode. When 

connecting to the I-Mark control via a switch or network you should use a standard CAT5e 

cable. If connecting the I-Mark control directly to a PC or laptop you will need to use a CAT5e 

crossover cable.   
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TABLE 1.3 SERIAL DATA PORT 

PIN RS232 PARAMETERS 

1 DCD BAUDRATE 115200 

2 RxD FLOW CONTROL NONE 

3 TxD PARITY NONE 

4 DTR DATA BITS 8 

5 GND STOP BIT 1 

6 DSR NOTE: SEE EXAMPLE BELOW FOR 

SAMPLE STRING FORMAT. 
7 RTS 

8 CTS 

STRING FORMAT FOR SENDING ASCII DATA TO I-Mark PLACEHOLDER 

NOTE: YOU CAN EDIT STRING CONFIGURATION IN I-MARK Config Tab 

[ : ]   “DATA TO BE MARKED”   [CRLF] 

 

 

 

1 5 

6 9 

START OF 

STRING 

DATA TO BE 

PRINTED BY 

MARKING 

HEAD 

END OF 

STRING 
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TABLE 1.4 I/O OUTPUT CONNECTIONS 

PIN DESCRIPTION 

1 [24VDC] Common (Customer to supply.)  

2 [0VDC] Common (Customer to supply.) 

3 READY 

4 MARKING 

5 CYCLE COMPLETE 

6 FAULTED 

7 USER OUTPUT (programmable) 

8 USER OUTPUT (programmable) 

9 USER OUTPUT (programmable) 

10 USER OUTPUT (programmable) 

11 AUX. [ 24VDC ] (.5a MAX) 

12 AUX  [ 0VDC ]   (.5a MAX) 

13-25 RESERVED 

Note: 80ma max draw per output 

 

 

1

3 

1 

2

5 

1

4 
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TABLE 1.5 I/O INPUT CONNECTIONS 

PIN DESCRIPTION 

1 
 [0VDC] Common (pins 2-4) (Customer to 

supply.)  

2 START 

3 RESET 

4 SELECT BIT-1 (BINARY) 

5 SELECT BIT-2 (BINARY) 

6 SELECT BIT-3 (BINARY) 

7 SELECT BIT-4 (BINARY) 

8 USER INPUT (programmable) 

9 USER INPUT (programmable) 

10  [ 0VDC] Common (5-9) (Customer to supply.) 

13 
E-Stop  (must be held high for normal 

operation when this option is enabled)  

  

 

 

1 1

3 

1

4 

2

5 
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Start Button 

The I-Mark Start Button (sold separately by Columbia Marking Tools) allows a marking 

program to be executed repeatedly without interacting with the I-Mark software. This feature is 

ideal for production environments where a PC is not available during marking or when mouse 

and keyboard operation is not desired. 

When pressed, the start button triggers the marking layout assigned to Slot 0 in the controller. 

 

Hardware Setup 

1. Plug the 25-pin connector into the back of the I-Mark Controller. 

2. Ensure the connector is properly seated in the Input and Output ports as labeled on the 

controller. 

 

Assigning a Layout to the Start Button 

1. Open the I-Mark software. 

2. Navigate to the Controller ribbon and select Layouts. 

o This opens the Layout Configuration dialog. 

3. Use the drop-down menu to assign the desired marking layout to Slot 0. 

o When the controller receives a start signal from the external push button, it will 

execute the program assigned to Slot 0. 

 

Activating the Configuration 

1. After assigning the desired layout to Slot 0, navigate to the Controller Page. 

2. Click Download to save the layout and start button configuration to the controller. 



 

Page 108 
 

3. Once downloaded, pressing the start button will execute the assigned program. 

 

Best Practices 

• Always verify the correct marking layout is assigned to Slot 0 before operation. 

• Ensure all 25-pin connections are firmly seated in the correct input/output ports. 

• Test the start button in a safe environment prior to full production use to confirm proper 

operation. 

THINGS IN THIS SECTION ARE SUBJECT TO CHANGE IF YOUR FACTORY HAS 

DIFFERENT POLICIES FOR START BUTTONS SUCH AS HAVING AN ABORT BUTTON.  
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Configure I-Mark for Stream UI Plugin 

The StreamUI plugin is designed to allow the user of I-Mark to select the program they wish to 

run from the User Interface and press an External Start button to run that selected program. 

Depending on your use case, you may want to use the Stream UI plugin. This plugin streams 

all layouts directly from the PC, eliminating the need to manually download and sync files 

to the controller. In other words, it uses all the files stored in the workspace rather than 

relying on the files stored on the controller. 

To activate the plug-in, let’s start by opening Windows Explorer and navigating to your I-Mark 

Installation directory. Typically, this is C:\Program Files (x86)\I-Mark_x.xxx.xxx.xxx\ 

Open the “Plugins/Not Used” folder and copy the file named “StreamUI.dll.” 
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Move backwards one directory to the “Plugins” folder and paste the “StreamUI.dll” file here. 
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At this time, you can close Windows Explorer and open up the 

I-Mark software. When the I-Mark software is opened, 

Navigate to the controller page for the Marking System. This 

usually opens automatically for our M-Series (M75, M125) 

customers. However, if not you can open the controller page 

by Right Clicking on the Controller Icon for your machine found 

at the top of the “Navigation” panel. 

 

After you have the controller page open in the center panel of 

the software, select the “IO” button on the Controller’s ribbon 

menu. 

 

Make the following changes to the I/O 

configuration in this page and press OK.  

Once this is completed Press the “Download” 

button on the controller page to affect the 

changes into the controller. The controller will 

restart automatically after the download is 

completed. Once you select a marking layout 

from the “Status and Control” tab, the layout 

which is selected will now become the active 

marking layout. Anytime the controller 

receives a Start Input on the discrete I/O, the 

program which is selected will then begin 

marking. 
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It is no longer required for you to “Download” your layout selections, change the selected layout 

to your desired Layout for marking. 

After you add a plug in a restart of the application may be necessary. 

 

 

For any other questions or concerns, please contact CMT Service dept. At 1 (800) 4MY-MARK 

or by email, service@columbiamt.com .  

mailto:service@columbiamt.com
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Backing Up your I-Mark Layouts 

Regular backups of files is always important to aid in recovery from technical issues, but 

backing up your I- Mark Layouts is also a good way to move Layouts between multiple marking 

machines, if needed. 

We recommend using a USB drive, but you can also back these files up to a network drive or 

just another folder on the same PC. 

Method 1 

1. Open your File Explorer, and navigate to: 

C:\Users\Public\Documents\I-

Mark\Basic 

2. Select the layouts you want to copy by 

holding CTRL while clicking on each 

layout name (or click the fist layout, then 

hold SHIFT and click the last layout to 

select all) 

3. You can either drag and drop the 

layouts onto your USB, or use your preferred copy/ paste method. 

Method 2 

1. Open I-Mark, select File > Extport >Layouts. 

2. When the list pops up, select all layouts you wish to save 

and hit “OK,” then select a folder to save the export. You 

can name the exported file at this point, as well. 

3. The. cmtlx file create is a compressed ZIP file that makes it 

easy to move the layouts from one PC to another. You can 

import this. cmtlx file with File > Import > Layouts in I-Mark. 
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Serial Data String 

I-Mark can monitor the Serial Data register.  

Depending on which version of I-Mark you are using, we give you the ability to change the data 

characters in the software so you can specify yourself which one I-Mark should be looking for in 

the serial string.  

However, if you are not using I-Mark v 1.2.1.7 or Greater than the default setting for this would 

be as listed below. 

Serial Communication Settings 

Baud Rate: 9600 

Data Bits: 8 

Parity: None 

Stop Bits: 1 

Flow Control: None 

By default, the terminating character for the 

starts of a data string is the Colon “:” then any 

data following that (Up to 80 characters) is 

what will be marked in the placeholder 0 (%p0 in I-Mark).  

Then to terminate the string I-Mark will look for CR (Carraige Return [Dec 13 or Hex D]) and LF 

(Line feed [Dec 10 or Hex A]). 

When you have the string formatted correctly then you should be able to send it to the I-Mark 1 

time any as long as it is powered up and it will retain that string and continue to mark it when 

called until you send it new data which will overwrite it.  
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Configuring IP Address 

Default IP Address 

• All controllers ship with the default IP address: 

10.1.10.225 

 

Option 1: Leave Controller at Default IP 

If keeping the controller at its default IP: 

• Change the IPv4 settings on your PC to match the controller’s network 

 

Option 2: Change the IP Address on the Controller 

When operating multiple controllers in a cell, change the IP address on the controller itself 

using the I-Mark application. 

If the Controller Cannot Be Reached 

• On startup, I-Mark will display: 

“Error: Failed to connect to marking machine. Do you wish to set up the IP address 

of unreachable machines?”  

• Click Yes 

Ignore local and Wi-Fi connections. Focus on the Ethernet adapter or the machine name 

under Network Connections. 

 

IP Setup Procedure 

1. Highlight the machine name you wish to configure 

2. Click Modify 

3. Ensure “Maintain IP address automatically” is unchecked 

4. Select the appropriate network adapter 

5. Click Suggest Values 

o This aligns the controller’s IP with the selected network adapter 
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o Alternatively, you may manually assign an IP 

 

Manual IP Assignment Guidelines 

• Use: 10.1.10.xxx 

• The final number should be within the range of 1 to 254 

• The PC network adapter IP and controller IP must NOT be identical, or connection 

will fail 

Subnet mask and default gateway may be adjusted if required. 

Your IT or controls department can assist with advanced network configurations. 

IP Error 

If your network is not matching up with your computers IP address you will receive an error 

message, if you get the message you will need to modify your computers local area connection.  

 

Select yes to obtain the machines current IP address and suggested local values.  

If you are connecting your marker to a network that is already configured modify the controller 

only to match existing network configuration.  
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If your computer is NOT on an existing network you need to change the IP address of the local 

area connection. 

The controller ships with the following IP address set already 10.1.10.225. 

A recommended setting for your local are connection would look like 10.1.10.226 

You will need to go into your computers network settings and modify. 
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Replacing the Marking Stylus 

You may encounter a situation where the mark will start to look less clear than before. Or 

perhaps that the marking has become sloppy. 90% of the time, this is caused by a broken, 

chipped or worn marking stylus. Here is how to replace the pin. 

 

Start by unscrewing the pin housing from the M-

Series and removing it from the  machine. Then 

while holding the pin housing assembly firmly in 

your hand, press the pin downward against a 

hard surface to eject the pin out of the backside 

from the housing. 

 

Take the pin out of the housing and either 

sharpen or replace with a new one. CMT part # 

(IMIDPIN).  

 

To replace the pin, assemble the spring and pin back 

together according to this picture above and hold the 

assembly in your hand again. Now with you thumb press 

the piston side of the pin firmly into the housing to seat the 

pin the assembly. 

If you a have a hand Andy or extended pin set up contact CMT for possibility of  reshaping. 



 

Page 120 
 

Binary Select I/O 

Load the I-Mark Software and open the machine controller page. Note you can open the 

machine controller page by clicking on the desired machine in the navigation toolbar. 

 

The Machine does not have to be connected to setup the binary configuration but you will need 

to connect and download before your changes will take effect.  

 

Once you have opened the controller page find the “Layouts” Icon in the ribbon and select it. 

The Configure Binary Selection dialog should then appear as shown below. 

 

Once the Configuration dialog is open you can select each layout that you would like assigned 

to the corresponding binary bit. The image below shows an example of this.  

Once you have assigned your layouts click “Apply” and then okay to set them. You will then 

need to click save to store your settings before you download.  
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After you have saved your new binary configuration you will need to download it to the 

controller. 

 

If you are not connected click the connect button then click download. Your changes will be sent 

to the marking controller and stored in flash memory until you change them.  

 

(Note: these settings will remain in flash even through a power cycle.) 
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I-Mark Fatal Error Fix 

On rare occasions, I-Mark will throw a Fatal Error if the user 

database gets corrupted within Windows. This can happen for a 

number of reasons due to the volatility of Windows updates and 

registry changes, but thankfully, there is 

an easy fix.  

If the Fatal Error appears as I-Mark is attempting to start up, ensure 

that I-Mark is closed and follow these steps:  

1. Open your Windows File Explorer by pressing the Windows Key + E at the same time.  

Note: the Windows Key is a key on your keyboard with the Windows Logo (or some 

variation) on it. See the example screenshot on the right.   

2. Navigate to C:\Users\[username]\AppData\Local\Columbia_Marking_Tools\ 

Note: the “AppData” folder is typically hidden by default in Windows. To see hidden files and 

folders, go to “View” near the top-middle of the File Explorer window. Select Show then 

checkbox Hidden Items. Older versions of Windows may have this option under a slightly 

different menu in the File Explorer, but the same concept applies. 

Note: [username] should be whatever the profile name is on your system. For example, in 

my screenshot, the [username] is nmanciero. If your PC has more than one user profile on it, 

you may need to navigate to each one 

to find the Columbia_Marking_Tools 

folder.  

3.  Delete the Columbia_Marking_Tools 

folder. You may now close the File 

Explorer. This folder contains the 

corrupted user.config file.  

4. Start the I-Mark software.  

It may take an extra minute or so to 

start, since the I-Mark software will 

automatically rebuild the user database.  

If I-Mark functionality is not recovered after 
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following the steps in this guide, please reach out to us at service@columbiamt.com and 

reference your Support Ticket number. If you have not created a support ticket yet, please do so 

at http://marking-machines.net/Support_Request.html. Thank you! 



 

Page 124 
 

Fault Code Common Fix 

This section outlines the most common fault codes and recommended corrective actions. 

Common Fault Codes & Solutions 

Max Fonts 

• Cause: Microcontroller overload 

• Solution: 

1. Click Download 

2. Save your layout 

3. Restart the marking machine 

 

Key Expired 

• Cause: License key expiration 

• Solution: Contact CMT to obtain an updated license key 

 

Marking Machine Application Task Not Running 

• Cause: Malfunction of firmware 

• Solution: Restart the controller or power cycle the controller 

 

Marking Machine Utility Task Not Running 

• Cause: Malfunction of firmware 

• Solution: Restart the controller or power cycle the controller 

 

Timed Out While Holding 

• Possible Causes: 

o Marking head is not plugged in 
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o Mechanical issue with the marking head 

• Solution: 

o Verify all connections 

o If the issue persists, the marking head may need to be returned to CMT for repair 

 

Overcurrent Fault 

• Possible Causes: 

1. Marking machine has been idle for an extended period 

2. Rapid software commands (e.g., aborting a mark and immediately commanding 

Home) 

• Solution: 

o Press the Home hardware button on the controller 

 

General Recovery Procedure 

When in doubt or if the issue is unclear: 

1. Download the layout again 

2. If unresolved, restart or power cycle the controller 

If the issue persists and you have access: 

• Test the marking machine using a known working controller 

• Ensure the same version of I-Mark software is installed 

Important: When using integrated systems, all controllers must run the same software 

version. 

If no resolution is achieved, contact CMT for service or repair. 
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Fault Codes 

faultApp00 No Fault 

faultApp01 Layout Not Found 

faultApp02 Invalid Layout Opcode 

faultApp03 Invalid Layout bit count (max 5) 

faultApp04 Real Time Clock Failure, Time invalid 

faultApp05 Invalid Placeholder Index 

faultApp06 Placeholder Data is null 

faultApp07 Data Matrix data is too large 

faultApp08 Font Specified >= 64 

faultApp09 Font not found or not loaded. Max of 10 fonts. 

faultApp10 Graphic File not found 

faultApp11 Graphic File too large 

faultApp12 Invalid Graphic Alignment specified 

faultApp13 Invalid Line Style, expecting straight 

faultApp14 Invalid Line Sytle, expecting circular 

faultApp15 Bad Font Character 
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faultApp16 Invalid Text Alignment 

faultApp17 Invalid Text Direction 

faultApp18 Marking Aborted 

faultApp19 Bad Data Matrix Height 

faultApp20 Bad Data Matrix Square Percent 

faultApp21 Initialization Error, Missing or Corrupted Files 

faultApp22 Timed out while homing. 

faultApp23 Unknown parameter in Parameters#.txt 

faultApp24 Parameters#.txt not found 

faultApp25 Index Locate failure, Failed to detect probe 

faultApp26 Index Locate failure, Failed to move off probe 

faultApp27 Invalid user integer register specified in I/O statement 

faultApp28 
Invaild user integer register specified in write integer register 

command 

faultApp29 
Invaild user integer register specified in write floating point register 

command 

faultApp30 Invalid axis marking plane selected. 

faultApp31 Attempt to jog an axis that has not been homed 

faultApp32 Attempt to mark with an expired tool. 
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faultApp33 Key expired. 

faultApp34 Invalid Key ID 

faultApp35 Invalid Machine ID 

faultApp36 Write Register Entity is no longer supported. 

faultApplicationFault Application Fault (%%1): %%2 

faultApplicationFaultUnknown Unknown Application Fault: %%1 

faultAxis00 Position Error 

faultAxis01 Over Current 

faultAxis02 CW hardware limit 

faultAxis03 CCW hardware limit 

faultAxis04 CW software limit 

faultAxis05 CCW software limit 

faultAxis06 Amplifier 

faultAxis07 Position Feedback 

faultAxis08 Velocity Feedback 

faultAxis09 Hall sensor 

faultAxis10 Max Velocity Command 

faultAxis11 Emergency Stop 
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faultAxis12 Velocity error 

faultAxis13 Task 

faultAxis14 Probe Input 

faultAxis15 Auxiliary input 

faultAxis16 Safe Zone 

faultAxis17 Motor Temperature 

faultAxis18 Amplifier Temperature 

faultAxis19 External Encoder 

faultAxis20 Communications Lost 

faultAxis21 reserved21 

faultAxis22 reserved22 

faultAxis23 Feedback Scaling 

faultAxis24 reserved24 

faultAxis25 reserved25 

faultAxis26 reserved26 

faultAxis27 reserved27 

faultAxis28 reserved28 

faultAxis29 reserved29 
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faultAxis30 reserved30 

faultAxis31 reserved31 

faultAxisFault Axis %%1 Fault: %%2 

faultAxisFaultUnknown Axis %%1 Unknown Axis Fault: %%2 

faultFileConfigMissing Config.txt File Missing 

faultFileCounterMissing Counter.txt File Missing 

faultFileLanguageMissing CurrentLanguage.txt File Missing 

faultFileShiftMissing Shift.txt File Missing 

faultIMarkMainTask Marking Machine Application Task not running. 

faultIMarkUtilTask Marking Machine Utility Task not running. 

faultTask00 No Fault 

faultTask01 Argument Out of Bounds 

faultTask02 Invalid Register Type 

faultTask03 Port Already Open 

faultTask04 Invalid Sync Task 

faultTask05 Invalid Program Password 

faultTask06 Invalid Embedded Command Issued 

faultTask07 Corrup Flash Memory Found 
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faultTask08 Un-Implemented Command 

faultTask09 Modbus Register Regx 

faultTask10 Feature Not Supported By Hardware 

faultTask11 Axis is Currently In Fault 

faultTask12 Invalid Embedded Function Rev 

faultTask13 Task Not Enabled 

faultTask14 Code Section is too small 

faultTask15 Data Section is too small 

faultTask16 Compiler Version Mismatch 

faultTask17 Invalid Axis Given 

faultTask18 Invalid Axis Configuration 

faultTask19 CNC5 option required 

faultTask20 No Joystick Pairs Enabled 

faultTask21 File Name Is Too Large 

faultTask22 Insufficient File System Memory 

faultTask23 File Currently Exists 

faultTask24 File Does Not Exist 

faultTask25 Corrupt File Found 
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faultTask26 File Optimize Interrupt 

faultTask27 File Access Past End Of File 

faultTask28 File Not Open 

faultTask29 File Opened as Read-Only 

faultTask30 File Opened as Write-Only 

faultTask31 No File Handles Available 

faultTask32 File Already Open 

faultTask33 Read File Buffer Too Small 

faultTask34 File Write With CRC On 

faultTask35 Heap Allocation Failure 

faultTask36 Slab Heap Exhausted 

faultTask37 Axis Not In Tasks Plane 

faultTask38 Error On Firmware Upload 

faultTask39 Motion Active 

faultTask40 Profile Entry Error 

faultTask41 Invalid Home Configuration 

faultTask42 Amplifier Not Enabled 

faultTask43 Radius Specified With Full Circle 
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faultTask44 Radius Too Short for Arc 

faultTask45 Plane Profiling 

faultTask46 PV Length Error 

faultTask47 Splining Not Enabled 

faultTask48 Cam Abs Index In Current Plane 

faultTask49 Cam Not Enabled 

faultTask50 Cam Not Monotonic 

faultTask51 Cam Previously Enabled 

faultTask52 Cam Search Count Exceeded 

faultTask53 Cam Time Over-run 

faultTask54 Failed Cam Comm to Slave 

faultTask55 Invalid Cam Configurations 

faultTask56 Invalid Cam Context Cmd 

faultTask57 Invalid Cam List Size 

faultTask58 Master Not A Camming Axis 

faultTask59 No Cam Context 

faultTask60 Not Find Cam Segment 

faultTask61 Invalid First Last Cam Pos 
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faultTask62 No Gantry Slave Motion 

faultTask63 Corrupt Cam File Found 

faultTask64 Cam File Too Large 

faultTask65 Cam Table Not Loaded 

faultTask66 Cam Offset Out Of Table 

faultTask67 Stack Overflow 

faultTask68 Array Out Of Bounds 

faultTask69 Division by Zero 

faultTask70 String Assignment Overflow 

faultTask71 Sync Time Overrun 

faultTask72 Task Monitor Error 

faultTask73 OnTaskFault error 

faultTask74 Semaphore Starvation 

faultTask75 Circular Radius Error 

faultTask76 Feature Not Enabled 

faultTask77 Master Motion Suppressed 

faultTask78 Invalid Time Interval Specified for Move Command 

faultTask79 Invalid File Name 
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faultTask80 Invalid Motor Type 

faultTask81 MX is Reprogramming 

faultTask82 COM Port Not Open 

faultTask83 Joystick Interlock Open 

faultTask84 Flash Config Commit Failed 
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Conclusion, Support Resource, Contact 

Information 

The I-Mark software and marking system are designed to provide a precise, flexible, and reliable 

solution for permanent product identification and traceability. Through structured layouts, 

dynamic data handling, and advanced entities such as counters, placeholders, Data Matrix, and 

UID codes, operators are able to create marking programs that meet both operational and 

compliance-driven requirements. 

By following the workflows outlined in this manual—from workspace organization and layout 

creation to teaching, downloading, and execution—users can ensure consistent marking results 

while minimizing setup time and operator error. Proper use of Trial Runs, entity-specific settings, 

and hardware verification further supports safe operation and high-quality marking results 

across a wide range of materials and applications. 

This manual provides in-depth instructions covering the standard operation and configuration of 

I-Mark systems. However, additional support resources are available should further assistance 

be required. 

Additional Support Resources 

• Knowledgebase 

Access troubleshooting articles, FAQs, and guided solutions: 

https://i-mark.tawk.help/ 

• Technical Support Request 

Submit a formal support request at: 

https://marking-machines.net/Support_Request.html 

When submitting a request, please include: 

o Software type 

o Marking machine serial number 

o Description of the issue and operating conditions 

https://i-mark.tawk.help/
https://marking-machines.net/Support_Request.html
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Licensing Agreements: 

 

LICENSE GRANT 

Columbia Marking Tools grants you a non-exclusive license to use this SOFTWARE, and any 

associated documentation, as indicated herein. A Single Site License is given to the purchaser 

of any machine within the I-Mark family of CMT’s products. This Single Site License, one copy 

of the SOFTWARE may be used for internal use only, for one machine. If you have purchased a 

Multiple User License (or you have purchased multiple machines at the time of purchase), the 

SOFTWARE may be used, for internal purposes only, by the number of machines authorized at 

the time of purchase. The SOFTWARE is in "use" by a USER when it has been loaded into the 

temporary memory (i.e. RAM) of the USER's computer. 

 

The USER MAY: (a) use the SOFTWARE in a company, corporate or organization; (b) use the 

software to create designs and or sequential programs created with the SOFTWARE in 

commercial projects; (c) make a copy of the SOFTWARE for archival purpose only; (d) install 

the SOFTWARE on another computer only if the User is to make a change of workstation. In 

such a case the user must uninstall the software from the previous workstation; (e) install the 

SOFTWARE on a second personal computer, such as a laptop or a home computer, only if the 

USER is the main person to operate this computer. 

 

RESTRICTIONS 

The USER MAY NOT: (a) copy and distribute the SOFTWARE or any portion of it; (b) 

sublicense, lease, rent, or transfer this SOFTWARE to another; (c) cause or permit reverse 

engineering, disassembly, de-compilation or alteration of this SOFTWARE; (d) remove any 

product identification, copyright notices, or other notices or proprietary restrictions from this 

SOFTWARE; (e) copy the documentation accompanying the SOFTWARE.. 

 

SUPPORT AND MAINTENANCE 
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COLUMBIA MARKING TOOLS provides support on the SOFTWARE by means of online help, 

documentation, tutorials, knowledge-base and all other article freely accessible on COLUMBIA 

MARKING TOOLS’ websites. Email-based support is provided on Columbia Marking Tools 

website as part of this license.  

 

During use of the SOFTWARE you may also report any SOFTWARE problem to COLUMBIA 

MARKING TOOLS. If COLUMBIA MARKING TOOLS determines that a reported reproducible 

error in the Software exists and significantly impairs the usability and utility of the Software, 

COLUMBIA MARKING TOOLS agrees to use reasonable commercial efforts to correct or 

provide a usable work-around solution in an upcoming maintenance release or update, which is 

made available at certain times at Columbia Marking Tools’ sole discretion. 

 

UPGRADES AND PATCHES 

Upgrades to this SOFTWARE are available through the product page on COLUMBIA MARKING 

TOOLS’ websites by purchase only (unless otherwise stipulated by COLUMBIA MARKING 

TOOLS on a per case basis). Any Upgrades applied to the SOFTWARE must comply with the 

TERMS and RESTRICTIONS in the previous and forward sections of this document as 

stipulated therein. UPGRADES may consist of performance enhancing changes to the 

SOFTWARE or new feature releases developed by COLUMBIA MARKING TOOLS for the use 

of this SOFTWARE only. Patches may be offered by COLUMBIA MARKING TOOLS to repair or 

change any portion of the program deemed to be malfunctioning or inadequate at the discretion 

of COLUMBIA MARKING TOOLS. At the time of installation of said patched, please review any 

and all documentation provided before applying changes to the program to avoid any 

undesirable result from the update. (Please report any undesired behavior to COLUMBIA 

MARKING TOOLS) 

 

TERMS 

This License is effective until terminated. You may terminate it at any time by destroying the 

SOFTWARE, together with all copies thereof. This License will also terminate if you fail to 
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comply with any term or condition of this Agreement. Upon such termination, you agree to 

destroy the SOFTWARE, together with all copies thereof. 

 

COPYRIGHT/OWNERSHIP 

This SOFTWARE and its source code are proprietary products of COLUMBIA MARKING 

TOOLS and are protected by copyright and other intellectual property laws. The SOFTWARE is 

licensed and not sold. You acquire only the right to use the SOFTWARE and do not acquire any 

rights, express or implied, in the SOFTWARE other than those specified in this License. 

Interaction or inclusion of parts of the SOFTWARE in third-party products does not mean that 

the SOFTWARE, or any portion of it, is part of these products nor property of the companies 

owning these products.  

 

DISCLAIMER OF WARRANTIES 

COLUMBIA MARKING TOOLS DOES NOT WARRANT THAT: (A) THE OPERATION OF THE 

SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE OR THAT FUNCTIONS 

CONTAINED IN THE SOFTWARE WILL OPERATE IN COMBINATIONS OF SOFTWARE OR 

HARDWARE THAT MAY BE SELECTED FOR USE BY YOU; (B) THE SOFTWARE WILL 

MEET YOUR REQUIREMENTS OR EXPECTATIONS; OR (C) ANY RESULTS, OUTPUT, OR 

DATA GENERATED BY THE SOFTWARE WILL BE FUNCTIONAL, COMPLETE OR 

RELIABLE. EXCEPT AS EXPRESSLY STATED IN THIS SECTION, TO THE MAXIMUM 

EXTENT PERMITTED BY LAW, COLUMBIA MARKING TOOLS SPECIFICALLY DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, ORAL OR WRITTEN, RELATING TO 

THIS AGREEMENT AND THE SOFTWARE AND ANY SERVICES PROVIDED TO YOU, 

INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD 

PARTY RIGHTS. 
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DISCLAIMER OF DAMAGES 

THE LIABILITY OF COLUMBIA MARKING TOOLS UNDER THIS AGREEMENT, 

REGARDLESS OF THE BASIS OF LIABILITY OR THE FORM OF ACTION, WILL NOT 

EXCEED THE FEES PAID TO COLUMBIA MARKING TOOLS FOR THE PORTION OF THE 

SOFTWARE OR SERVICES CAUSING THE LIABILITY. IN NO EVENT WILL COLUMBIA 

MARKING TOOLS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 

CONSEQUENTIAL DAMAGES, HOWEVER CAUSED, WHETHER FOR BREACH OF 

CONTRACT, NEGLIGENCE OR OTHERWISE, AND REGARDLESS OF WHETHER 

COLUMBIA MARKING TOOLS HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE 

DAMAGES, INCLUDING WITHOUT LIMITATION, THE USE OR INABILITY TO USE THE 

SOFTWARE, OR ANY RESULTS OBTAINED FROM OR THROUGH THE SOFTWARE. 

 

 

 

 

 

 




